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Preface 
 

Thank you for purchasing the X-618 Public Address and Voice Alarm System. Please carefully 

read this manual prior to product use so as to ensure correct use of the system. 

Brief Introduction 

This manual describes the basic operations and settings for the X-618 Config software, contained 

in the following sections: 

Chapter 1: Overview 

This section introduces the basic functions, runtime environment, and the necessary preparation 

required before operating or configuring the software. 

Chapter 2: Software Installation 

This section describes the runtime environment and the installation and uninstallation procedures 

for the X-618 Config software.  

Chapter 3: Basic Operations 

This section describes the basic operations of the X-618 Config software. 

Chapter 4: Configuration Guide 

This section describes various details regarding the settings and operations for the X-618 Config 

software. 

Chapter 5: Additional Function 

This section describes special functions and operations of the X-618 Config software. 

Intended Reader 

This manual is mainly for personnel who need to install, operate, maintain, and understand the X-

618 Config software. 

Relevant Documents 

The following documents can be used as a reference when reading this manual: 

• X-618 Public Address and Voice Alarm System Product Description 

• X-618 Public Address and Voice Alarm System Installation Manual 

• X-618 Public Address and Voice Alarm System Operation Manual 

• X-DCS2000/EN Digital Integrated System Manager Product Instructions 

• X-DCS3000 Digital Integrated System Manager Product Instructions 

• X-NPMI Configurable Network Paging Console Product Instructions 

• X-NPMS Configurable Network Paging Console Product Instructions 

• X-NRI Network Resource Interface Product Instructions 

Use Instructions 

• All contents including figures in this manual are to be used only for reference. 

• The product may be subject to change from time to time without notice. 

• Users of this product are recommended to carefully read all warnings and precautions in this 

manual. 

• Carefully read this manual before using the product and keep it as a reference for future use. 

• This manual has been reviewed with its accuracy is ensured. In case of any doubt or dispute 

of the product description, the final interpretation given by Life Safety A/V (Guangzhou) Co., 

Ltd. shall prevail. 



 

 

• Life Safety A/V (Guangzhou) Co., Ltd is not liable for any consequences caused by user 

mistakes when using the product or user misunderstandings of the manual content. 

 

Network Security 

Placement 

• Please put the device in a safe place, lock the cabinet and keep the keys well. 

• The access control system of the central control room should be under strict management. 

• Any person except authorized maintainer is forbidden to disassemble or change parts of 

device. 

• It is forbidden to communicate X-618 system with third party system unless updating the 

configuration. 

Password Precaution 

• Please change the password during the system deployment. 

• Users need to change the password regularly, or there will be a risk. 

• The password with eight numbers is preferred. The default password is hon12345. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

1    System Overview 
The X-618 provides a series of complete multiple sound source public audio management 

solutions. The system allows users to customize the configuration to meet their own requirements. 

The X-618 Config software is a specialized tool for configuring the system. The user-friendly UI 

allows users to easily understand and operate the system, as well as configure complex settings. 

The X-618 Config software can be configured online or offline. If the software is configured offline, 

the configuration data is saved as a project file. The configuration file is uploaded to the device 

system, once the configuration software has been installed on a computer and that computer is 

connected to the system. After the system receives the configuration data, the system reboots 

automatically to allow the configuration settings to take effect. 

Software Features 

The X-618 Config software has the following features: 

• Project File Management 

This feature includes the following functions: 

− The ability to create new projects, save projects, and open projects  

− Manages configuration settings and audio files 

• System Configuration 

The configuration settings include basic property settings and broadcast function 

configurations. 

− Basic property settings include the system component and parameter settings, such as 

the device type, device name, network IP address, time, partitions, and troubleshooting. 

− The broadcast configuration settings are mainly for broadcast operations, such as the 

broadcast function triggered by the dry contact inputs, timed broadcasts, and other key 

operations.  

• Output Settings 

These settings specify how configuration project files are generated, as well as related settings 

that include error checking and compiling settings for generating the final configuration file.  

• Audio Source Conversion 

Audio source files can be converted to the format specified by system in terms of the audio 

sampling rate, digitalizing bit, and channel numbers.  

• Network Communication 

The configuration software oversees uploading configuration files, audio files and timing data 

to devices such as the DCS and NPM through the network. The system reboots to allow new 

configurations to take effect upon successfully receiving and processing the configuration files.  

 

 

 

 

 

 

 

 

 

 

 

 



 

 

2    Software Installation 
 

This chapter describes the runtime environment and installation and uninstallation procedures of 

the X-618 Config software. 

Running Environment 

The X-618 Config software sends configuration data to devices within the system through the 

network. The computer on which the software is installed must meet the following requirements: 

• Windows XP, Windows 7, Windows 8 or Windows 10 operating system 

• 1GHz or higher CPU 

• At least 512MB RAM 

• At least 1GB of available disk space 

• 10M/100M Ethernet interface 

• Running at 1024X768 resolution or higher 

• The software should be granted network access by firewall. 

Software Installation 

The X-618 Config software is easy to install by following an installation wizard. 

1. Put the X-618 system CD into the CD-ROM drive, click X-618 System  Commissioning Tool in 

the Autorun view or double-click the installation program X-618 Config.exe, and the X-618 

Config installation wizard window displays as shown below. 

  

Figure 1 X-618 Config Installation Wizard Page 

 

2. Click Next. The License Agreement page is displayed. 

3. Select I Agree on the page. 

4. Click Next. The information page is displayed. 

Read the important information on this page before proceeding to the next step. 

5. Click Next. The page will be shown below.  



 

 

The default installation directory is C:\Program Files\X-618 Config. If this directory must be 

changed, click Browse to choose a different destination location. 

  

Figure 2 Select Destination Location 

 

6. Click Next. The Additional Tasks page is displayed. 

7. To create a desktop shortcut for running the software, select Create a desktop shortcut option. 

8. Click Next. The Ready to install page is displayed. 

9. Click Install. The Installing page is displayed. 

The X-618 Config software is then installed on the computer. The installation progress is 

displayed. 

10. Click Next. The information page is displayed. 

Read the information carefully on this page before proceeding with the installation. 

11. Click Next. The X-618 Config Completion page is displayed. 

12. If you need to start the X-618 Config software immediately, select the option Launch X-618 

Config. Finally, click Finish to complete the software installation. 

Software Uninstallation 

To uninstall the X-618 Config software, follow the steps below: 

1. Click Start at the lower left of your computer desktop, and select Program → X-618 Config → 

Uninstall X-618 Config. A prompt dialog appears with the message “Are you sure to remove 

the X-618 Config and its all components?”. 

2. Click Yes to uninstall the X-618 Config software and all of its components. The prompt dialog 

“Some content cannot be deleted, you can manually remove them” is displayed. 

3. Click OK. 

  Note: 

If you want to delete the remaining files manually, you can find and delete the X-618 Config 

software folder within the installation directory. 

 



 

 

3    Basic Operations 
 

           This chapter describes the basic operations of the X-618 Config software. 

Running the Software  

 Note: 

Make sure X-SMART software and the X-618 Config software can’t be operated at the same time. 

If the X-SMART software is running, only it has been closed, the X-618 Contig software can be run. 

The steps for running the software are as follows: 

1. Click Start at the lower left of your computer desktop, and select Program→ X-618 Config→ X-

618 Config.  

2. Select the menu commands Tools→ Select Language, the Select Language window is 

displayed, and the user can select the befitting language as needed, and click OK. The main 

window which is shown in English as below.  

 

Figure 3 X-618 Config Software Initial Window 

Exiting the Software 

Select the menu commands Project→ Exit or click the “X” icon on the upper right corner, and a 

prompt dialogue displays. Click Yes in this prompt dialogue to exit the software. 

 

 

 

 

 

 

 

 



 

 

Main Window Introduce 

The identifiers of the various views in the Config software main window is shown as below. Users 

can understand the descriptions in this manual easier. 

 

                                     Figure 4 Main Window introduce 

Menu Bar 

Menu bar includes Project, Tools and Help, and provides some basic operations. 

• Project 

Users can do the operations through the Project menu as follows: “New”, “Open”, “Save as”, 

“Recent projects”, “Project Properties”, “Close”, “Exit”. 

                        

• Tools  

The Tools menu provides some special operations, such as:” Browse Recorded Files in DCS”,” 

Browse Record Files in X-NPMS”, “Export Device List”, “Upload Project File from DCS to PC”, 

“Virtual Console”, “Browse log in X-DCS3000”, “Browse log in X-NPMS”,” Upgrade DCS/NRI/X-

NPMS Firmware”,” Upgrade X-NPM Firmware”, “Setup Project Passport”, “Setup Device Passport” 

and “Select Language”. 
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• Help  

The Help menu of the X-618 Config software provides the software version information and the 

help information for the operation of the software. 

Navigation Buttons 

For making system configuration convenient, there are 4 navigation buttons in the top of the view. 

So the users can find the specific setting subjects quickly. 

• Device  

The Device button leads to set the basic function parameters of the devices. The setting items 

which depend on the device type mainly include: Properties, Time, Supervision and so on. 

• Task 

Click the Task button to set broadcast task. The users can set the various broadcast operations as 

the X-618 system needed. Mainly include: Play List, Task and Task Serial. 

• Operation 

Click the Operation button to set the various operation functions, such as the keys and the 

appointed tasks for them, contact input, timing. 

• Download 

Click the Download button to verify that configurations are correct or not. If errors are found, an 

error list will be shown. If all the configurations are correct, then it will enter the configuration 

download window. 

Project Explorer View 

The project explorer view mainly shows all devices and groups in the system. It is necessary to 

select the devices to make the relevant configurations one by one.  

• Project Explorer  

The Project explorer is shown in a tree - like structure. The first level show the project name, the 

second level shows the groups, and the third level shows all the detailed devices. Just as shown 

below. 



 

 

                        

 Figure 5 Project Explorer Structure 

• Device and Group 

The devices may be classified into different groups according to different project structures and 

building’s characteristics. When fire alarm signals are detected, the devices in the same group will 

connect with each other and respond at the same time. Users can set the group as Central Group. 

Device from Central Group can execute broadcast operation on the whole groups, however, the 

device from local group can only operate on the device from the same group. Similarly, the audio 

source from Central Group can be played to all groups, but the audio source from local group can 

be only played in the same group. All the fire broadcast in the groups can be only valid in the same 

group, and the emergency broadcast can’t be played. If there is in need, users can play it through 

the fire controller.       

According to Right-click, the users can add, delete or rename the devices and groups. 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

4    Configuration Guide 
 

The X-DCS2000/EN, X-DCS2000PLUS, X-DCS3000, X-NPMI, X-NPMS, X-NPMIC, X-NPMK, X-

NRI can be configured through the X-618 Config software. 

 

X-Config Configurations Flow： 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The configuration content is different, according to the device type.  

1. The X-DCS2000/EN enables configuring the following settings: 

• Device 

- Properties 

- Time 

- Supervision 

- AVC  

- Standby 

• Task 

- Play List 

- Task 

- Task serial 

• Operation 

- Operation 

- Timing 

 

 

 

 

 

New project 

Edit project 

Open project 

 

Device 

Task 

Operation 

Download 

Group operation (Add, Rename, Delete) 

Device operation (Add, Copy, Paste, Rename, Delete) 

 

   

Set the basic parameters of the device 

    

Set the audio files and play list 

Set the task list and the task serial 

 

   

Set the tasks or the task serial for the keys, contact and 

timing 

 
   

Download the audio files, configuration files and timing 

data to the devices 

 
   



 

 

2. The X-DCS2000PLUS enables configuring the following settings: 

• Device 

- Properties 

- Modules 

       - Amplifier 

       - Time 

       - Supervision 

- AVC  

• Task 

- Play List 

- Task 

- Task serial 

• Operation 

- Operation 

- Timing 

3. The X-DCS3000 enables configuring the following settings: 

• Device 

- Properties 

- Modules 

       - Amplifier 

       - Time 

       - Supervision 

- AVC  

• Task 

- Play List 

- Task 

- Task serial 

• Operation 

- Operation 

- Timing 

4. The X-NPMI enables configuring the following settings: 

• Device 

- Properties 

- Devices 

- Groups 

• Task 

- Play List 

- Task 

• Operation 

- Operation 

5. The X-NPMS enables configuring the following settings: 

• Device 

- Properties 

- Time 

- Language 

- Supervision 



 

 

- Devices 

- Groups 

• Task 

- Play List 

- Task 

• Operation 

- Physical Keys 

- One-Click Buttons 

- Manually Broadcast 

- Speech Synthesis 

- Volume Setting 

- User Setting 

6. The X-NPMIC enables configuring the following settings: 

• Device 

- Properties 

- Time 

- Supervision 

- Devices 

- Groups 

• Task 

- Play List 

- Task 

• Operation 

- Physical Keys 

7. The X-NPMK enables configuring the following settings: 

• Device 

- Properties 

- Time 

- Supervision 

- Devices 

- Groups 

• Task 

- Play List 

- Task 

• Operation 

- Physical Keys 

8. The X-NRI enables configuring the following settings: 

• Device 

- Properties 

- Supervision 

- Linkage 

• Task 

- Play List 

- Task 

- Groups 

 



 

 

Preparation  

Before configuring the system, the following must be prepared: 

• Make clear the types and the qty. of the devices to form the system. 

• Make clear the system need to provide all the functions for broadcast. 

• Make sure the IP address and the device IP address in the same segment if want to download 

the configuration file. 

Project Settings 

All the settings for the X-618 system are based on the concept of a “project”. A project comprises 

of many groups which form from DCS subsystems, NRI, X-NPMI and X-NPMS. Each subsystem is 

a system unit that has a DCS with a power amplifier and corresponding speaker circuits.  

Every new project has a unique folder which creates in a specified storage path at first, for storing 

the related project files. The project folder name and the project *.gpa file name are by default the 

project name. The project folder contains project file, audio files and the other temporary files. 

The setting operations include following content:  

• New  

• Open 

• Save as  

• Recent Projects 

• Project Properties 

• Close 

New 

The New icon in the menu bar is used for creating a project. The steps are as follows: 

1. Select the menu command Project → New in the X-618 Config software window, as show 

below. The New Project window is displayed, as shown below. 

2. Refer to the example shown below to set the Project name, Location and Device Group Name, 

if set as the Central and Project Passport. The default directory for the project file is “My 

Documents”. This directly path can be changed. Click the icon at the right side of the 

Location path field to select a different directory. 

 

 

                          Figure 6 New Project Window 

 

 

 



 

 

3. Click the OK button to create the project. The window as shown below. 

 

                                          Figure 7 Created Project Sample 

 

4. Right-clicking the mouse in the Project explorer view causes a menu to pop-up to add, rename 

or delete Group, and also to add, copy, paste, rename or delete Device.  

• Right-click Project Name, the Group can be added; 

• Right-click one Group, the device of the Group can be added, pasted, renamed or deleted; 

• Right-click one device, the device can be copied, renamed or deleted, and another device can 

be added or pasted. 

Open 

1. Select the menu command Project → Open in the X-618 Config software window. The Open 

window is displayed.  

2. Find and open the project file. 

3. Click the Open button. The selected project is then opened.  

Save as 

1.  Select the menu command Project → Save as in the X-618 Config software window. The 

Save as window is displayed.  

2. Enter the new project name and select the storage directory for the project file. 

3. Click the OK button. Then the project is saved as another file.  

Recent projects 

1.  Select the menu command Project → Recent projects in the X-618 Config software window.  

2. The menu will show 5 projects recently opened. Click the project item as necessary to open it. 

Project Properties 

Select the menu command Project → Project Properties in the X-618 Config software window, the 

basic information, such as Compatibility, Net Package Size and Project Name can be displayed to 

help the users manage the files.    



 

 

 

1. Compatibility is used to set the audio parameter to make the X-DCS2000/EN work normally 

with the X-DCS3000 in the same system. If it is necessary to use X-DCS2000/EN in the 

system, users need to select “Compatible with X-DCS2000/EN”. Choose “Only X-DCS3000” 

will cause fault broadcast on X-DCS2000/EN when the system is playing audio resource of X-

NPMS and X-DCS3000. 

2. The net package sizes of X-DCS3000 and X-NPMS are 2KB or 4KB. The network broadcast 

delay of 2KB size is 50msec; however, the broadcast delay of 4KB size is 100msec. X-

DCS2000/EN, X-NRI and X-NPMI only support 4KB net package size. Therefore, choose 4KB 

net package size when use above devices, or some audio will not be broadcasted normally. 

On the other hand, 2KB net package size is better for X-DCS3000 and X-NPMS. 

3. Remark information like project name, can be filled in according to requirements, which will not 

affect system performance. If X-NPMS is used in the system, the project name will be 

displayed in X-NPMS standby screen. 

Close 

Click “Close” can close project items, but not exit the software. 

Project Saving Setting 

There is no special save menu or button in this software to make the operation easier and clearer. 

As project setting, the software will save it automatically. 

Group and Device Management 

After creating and setting project, default group is displayed in the window. Right-click the project 

name at the top of “Project Explorer” tree-like structure, and then click the item “add” to add new 

groups. The window is shown as following. 

 

Input a group name and set as the central group according to internal system relationship. Click 

“OK” to add into project, and click “Cancel” for not saving the settings. Users can add many groups 

for project files via this way, and generally we can only use default groups. 



 

 

  Note: 

Each group can be configurable with 32 DCS (X-DCS2000/EN and X-DCS3000) at most. In 

emergency mode, only the devices in the same group can be linked to X-NRI.  

Max. 8 NRI devices can be configured in a group, and audio sources of NRI can be broadcasted in 

the same local group. If NRI is in a central group, the audio sources of NRI can be broadcasted to 

all devices in system, but it can be linked to DCS of the same central group for emergency purpose. 

Up to 20 X-NPMI can be included in a group which is used to operate the devices in the group. If 

X-NPMI is in a central group, it can be used to control the devices in the same group.  

Up to 20 X-NPMS can be included in a group which is used to operate the devices in the group. If 

X-NPMS is in a central group, it can be used to control the devices in the whole system. 

  

Right-click a group and the window is shown as: 

 

1. Click the item “Add” to add device, as shown below:  

 

In this window, we can choose what device we need to add to, such as X-DCS2000/EN, “X-

DCS2000PLUS”, X-DCS3000, X-NPMI, X-NPMS or X-NRI, and set a device name. Click “OK” to 

save settings and close window. The all added devices will be displayed under the group, which is 

shown as following: 

 

Right-click the device name, we can operate the function of “Add”, “Copy”, “Paste”, “Rename” and 

“Delete”. The function of “Add” is the same as we have already described before. Through “Copy” 

and “Paste”, we can create a copy device, which has the same settings as the original one. Click 

“Rename” to fix device name, and “Delete” to remove device from the group. 

 



 

 

2. We can fix the group name through clicking “Rename”, and click “OK” to save settings and 

close window. 

 

3. Click “Delete” can remove all groups from project file. 

X-DCS2000/EN Settings 

Choose X-DCS2000/EN from “Project Explorer”, users can manage “Device”, “Task” and 

“Operation” through the 3 navigation buttons. 

• Device 

- Properties 

- Time 

- Supervision 

- AVC  

- Standby 

• Task 

- Play List 

- Task 

- Task serial 

• Operation 

- Operation 

- Timing 

Note：  

When add the device, users need to select X-DCS2000Plus, for X-DCS2000 is the old version. 

 

Device Settings 

The basic function parameters for the X-DCS2000/EN can be set under this tab. These items such 

as Properties, Time, Supervision, AVC, and Standby will be set in turn. 

1． Properties 

“Properties” is used to set the requisite parameters for the DCS working normally, as shown 

below： 



 

 

 

• Basic Setting 

Basic Setting includes Device ID, Device Name, Device Type, Emergency Button and Work Mode. 

➢ Device ID is the only device identification in the system, which in the range of 1~999. 

➢ The option “Emergency Button” is to enable or disable emergency button on X-DCS2000 

front panel. The checkbox shown as   means enabled. 

• Main Amplifier Setting 

It is used to set the main amplifier model, backup and resume. The amplifier supervision should be 

enabled, otherwise the backup function won’t work normally. 

• Network Setting 

Use to set the X-DCS2000/EN network parameter. Old IP is the IP address before setting, and 

New IP is the IP address after setting. For updating the network parameters of the system devices, 

it shall be connected to computer whose IP should be in the same segment with the old IP of X-

DCS2000/EN. Click the Update button for setting the IP of DCS, the two IP address would be the 

same after updating successfully. The default IP address is 192.168.2.200. If the specified IP 

address has been forgotten, the IP address can be obtained by pressing the appropriate buttons. 

• Fire Alarm Interface 

This item is used to set the fire alarm interface, including Disabled, Contact inputs, LPI-ModBus, 

Network-NRI. The default setting is disabled. 

➢ If select Dry Contact, the X-DCS2000/EN dry contact will receive the fire alarm signal 

directly. To fulfill the fire alarm function, the corresponding tasks of the Physical Contact 

Input List need to be set in the Operation tab. 

➢ If select LPI-ModBus, the DCS can communicate with fire alarm panel by LPI-ModBus 

directly. X-DCS2000/EN shall be in the slave mode at that time, and the Slave Address 

has to be set, and the range is 1~31. The introduction of LPI-ModBus module, please 

refer to LPI-ModBus converter User’s Manual. 

➢ If select Network-NRI, the fire alarm control panel should be connected with NRI ports, 

the fire alarm signal will be transmitted to NRI, and according to the preset linkage 

relationship to enabled the X-DCS2000/EN emergency voice alarm function. The 

corresponding settings please refer to the section of NRI Setting in this manual. 

Note: Network parameter is excluded in configuration files. Downloading configuration won’t 

change network configuration, which can be only changed by updating. While operating, please 

make sure device is connected to the network and the network settings are correct. 

 



 

 

• Zone List 

The Zone List setting function allows users to enable/disable the zones and set the Zone Name 

and Power. Check the check box shown as  to enable the corresponding zone. 

And   shows the zone is disabled. Click directly one zone name or power in the zone list to edit 

it. The power setting is used to determine if the amplifiers are appropriate. Power value in the zone 

list can’t represent anything and only record the actual power rate of speaker lines. 

Select one zone, and click the icon in the right of the Zone List, the rest of power can be set 

as the same as the selected zone’s. So the same power value will be set for all the zones quickly.  

• Storage 

Users can set the storage location as internal Flash or SD card and view the storage condition. 

The device already offered 606MB Flash storage and 4GB SD card.  

 

2． Time 

"Time” is used to set the time parameters of X-DCS3000, as shown below: 

 

•  “Synchronization Mode” is to set the parameters of time synchronization for X-DCS2000 

through NTP protocol. Default setting is off. 

➢ If NTP Server is enabled, X-DCS2000 will work as a time server, all devices 

synchronize the time with it. In other words, all devices’ time would be in 

conformance with the X-DCS2000’s. 

➢ If NTP Client is enabled, X-DCS2000 automatically synchronizes the time via a time 

server, the server IP address and synchronization period should be set. 

•  “Time Zone Setting” is used to set internal time zone of X-DCS2000. Choose the time zone of 

current location, and click “Update” button to change the time zone of X-DCS2000, if “All 

Devices” is selected, click “Update” will change the time zone of all devices. If the device time 

zone is different from the local time zone, the time and date will be wrong while time 

synchronization.  

 

• “Date & Time Setting” is used to view and manually update the device’s date and time. Click 

“Get” button to read the device’s date & date. If only click “Update” button, the time and date of 

current DCS will changed. If select “All Devices” and click “Update” button, the time and date 

of all device, such as X-DCS2000/EN, X-DCS3000, X-NPMS, X-NPMIC and X-NRI, will be 

changed. 

 

 



 

 

3． Supervision 

“Supervision” is used to enable or disable the supervision functions and the requisite parameter 

for check, as shown below： 

 

• Supervision Options 

Through the software, users can set the fault supervision for the AC Power, DC Power, Power 

Amplifier, PTT Mic Check, Communication, Speaker Line and Earth Fault enabled and disabled. 

• Line Supervision Setting 

If Line impedance is enabled, users can respectively enable/disable the line supervision function of 

the enabled speaker lines and set the line tolerance parameters. When the line impedance is lower 

than the lower limit, a short circuit will be found in the speaker line. When the impedance is higher 

than upper limit, an open circuit will be found in the speaker line. The default monitoring type is line 

impedance. If using end-of-line modules, EOL monitoring should also be selected. 

Select a line, and click the  icon in the right of the Line Supervision Setting list, the rest of 

parameters can be set as the same as the selected one’s. 

• Line Check Interval Time 

This item is used to set the measurement period of speaker line impedance. The value ranges 

from 10~1800s.  

 

 

 

 

 

 

 

 

 

 

 



 

 

4． AVC 

The AVC Setting function allows users to set the parameters for the AVC, as shown below: 

 

• AVC Input 

Select the AVC input channel, which should be matched with that in supervision module, and 

check the box to enable the AVC function of the selected channel. If channel is not equipped with 

noise detector, it can’t be selected.   

• AVC Parameter Setting 

➢ “Collection Time” is the supervision cycle of ambient noise. Its setting range is related to 

the No. of connected modules of device. 

➢ “Reaction Level” with the unit of dB is the bound value to enable the AVC function. When 

the sound pressure is equal or greater than this value, AVC function is enabled to adjust 

output volume automatically. When it is less than the bound value, the output volume is 

the minimum value. 

➢ “Sensor Deviation” means the deviation between the actual sound pressure level and the 

one measured by noise detector. Actual sound pressure can be measured by the sound 

pressure meter. Constant audio signal, such as white noise and sine wave can be played 

during the commissioning. Then the deviation can be got through measuring by the 

device and sound pressure meter. Any interference is forbidden during the measurement. 

➢ The “Level deviation (min)” is used to set the minimum volume of the adjusting range. 

➢ The “Level deviation (max)” is used to set the maximum volume can be adjusted through 

the AVC. 

➢ “Factor” provides the function to set the volume adjusting ratio, same kind of sound 

change, the bigger the adjusted ratio, the bigger the volume change.  

Broadcast volume calculation formula: 

Output Volume= (Ambient Noise+ Sensor Deviation- Reaction Level) X Factor+ Level 

deviation (min)  

• Read Data 

During the AVC settings, enable the read data function by selecting the check box. Information like 

measured value of ambient noise, actual value of ambient noise, reaction level, level deviation can 

be shown. 

 

 



 

 

5． Standby 

“Standby” is used to set the backup amplifier function.  

• Amplifier Type  

Users can choose the amplifier type, such as X-DA1500, X-DA2250 etc. 

• Standby Amplifier 

To select as the standby amplifier, users need to check the checkbox. 

• Resume 

Check the checkbox to select. 

• Standby Channel 

To choose which channel want to standby. 

Task Settings 

Task mainly used to set the necessary task for the broadcast by the X-DCS2000/EN. Each task 

includes audio library, play policy, zone setting and dry contact to fulfill all the play operations. 

Task setting includes Play List, Task and Task serial. 

1． Play List 

Play List is used to set the audio source and the play lists for the play tasks, as shown below: 

 

• Library 

The users have to configure the audio library first, if they want to play the audio files in the system. 

All the audio files’ basic messages, such as file name, size and length, would be shown in the 

audio library. And the total size can be gotten in the top of the Library. X-DCS2000/EN would share 

the audio library with X-DCS3000, X-NPMI, X-NPMS and NRI during configuration. And the 

required audio files can be downloaded to the devices through the system. 

Click  icon, the Open window is displayed. And the users can find and select one or more audio 

files from PC to add the audio file library. This software supports MP3 and WAV audio formats. 

And the other audio formats can be converted automatically to the audio format as system needed. 

Select one or more audio files, click   icon, the selected ones can be deleted from the library list. 

If the audio file wants to be deleted has added into some play list, the information window would be 

displayed to show that the file has been used, cannot be deleted. 

Right click in the list for Add and Delete menu also can do the audio files addition or deletion 

operation. 

 

• Play List 

After finishing the library setting, the play list can be created, and classified into two types:  Public 

and Private. The public play lists can be used by all the X-DCS2000/EN, X-DCS3000, X-NPMI and 

X-NPMS. And the private ones just for current X-DCS2000/EN.  



 

 

 

Click the  icon in the Play List view, the Add window is displayed as below: 

Enter the play list name, select the type from the drop - down menu, and click OK to create a new 

play list. 

Select one play list and click  icon or double-click the list, the Edit window for editing the play 

list name as needed, is displayed as below: 

 

Select some playlists in the Play List view click  icon to delete them. 

Right click in the list for Add, Edit and Delete menu also can do the play list addition, edit or 

deletion operation. 

 

• Contents 

Select some play list, the all the audio files of that list would be displayed in the Contents view. Left 

click and drag the audio files from the library to the Contents view, and the audio files have been 

added in the play list. 

Users can reorder the audio files as needed: 

a. Click  icon to move forward the selected audio file. 

b. Click  icon to move backward the selected audio file. 

c. Click  icon to delete the selected audio file. 

2． Task 

Task is used to view, add, modify or delete broadcast task, as shown below: 

 

• Task List 

There are many parameters of the all tasks displayed in the task list, such as task name, type, 

audio source, speaker lines, dry contact output, priority, loop, delay, resume, preview, busy wait, 

full and record. 

 

 



 

 

• Adding Play Task  

Click  icon in the upper right corner of the task list, and the Add window is displayed as below: 

  

Set the following parameters as needed: 

a. Task name: enter the task’s name to identify the task’s effect. 

b. Type: Normal or Emergency.  

➢ Normal is used for the public address such as the normal background music, 

operation broadcast, voice broadcast etc.  

➢ Emergency is used for the fire emergency broadcast. 

c. Audio Type: Play List, X-DCS2000/EN local AUX input, X-DCS2000/EN Record File, Net 
Audio or X-DCS2000/EN PTT 

➢ Play List: usually used for voice broadcast, background music etc. The users also can 

add the prompt tone files into the play list as needed. 

➢ AUX: External audio sources, such as DC player, connected to the device through the 

4 DCS auxiliary inputs, AUX1~AUX4 are selectable. 

➢ Record File: Configured in the X-DCS2000/EN and broadcasted through X-

DCS2000/EN operation. 

➢ Net Audio: Mainly external audio sources connected through NRI or NRI inner voice, 

which can be selected through the drop - down menu. 

➢ PTT: Configure a PTT to X-DCS2000/EN for paging. 

d. Policy: 

➢ Delay: Edit this field to specify a time in the range of 0~600 second for which the 

audio is delayed before being played. 

➢ Priority: The range of the value is different based on different task type. The Normal 

and Emergency task values must be between 56 ~ 255 and 1 ~ 55 respectively. If 

many play tasks are set to broadcast to the same zones simultaneously, the highest 

priority one would be played. And the smaller the value is, the higher the priority.  

➢ Loop: This item is available only to that selected audio type being play list or record 

file. It is used to set the play times in the range is 1~65535. 

➢ Forever: Enable/disable forever loop playback. 



 

 

➢ Preview: Check the check box or not to enable/disable the function which supports 

confirming the play contents according to auditioning them by the device’s built-in 

speakers in advance. 

➢ Busy wait: check the check box to enable the lower priority task which was in conflict 

with a higher priority one plays when the running task finished. Otherwise the task 

would be canceled automatically. 

➢ Resume: Enable or disable the shortcut task which was be broken off by the higher 

priority task resumes automatically when the insert task finished. 

➢ Full: Mainly used in emergency broadcast to keeps integrality of the new added task 

that comes the same audio source and play policy. If the check box is selected, the 

two combined tasks will be broadcasted from the beginning after the waiting audio 

and vice versa. 

➢ Record: Enable or disable to record the broadcast audio. Only valid when use 

microphone. 

• Speaker Lines 

Select the appropriate broadcast zones. Because of the tasks configured for X-DCS2000/EN only 

can be broadcasted in the local zones, the most 8 zones can be selected. Click  to select all, 

and click  to cancel all. 

• Dry Contact Output  

Check the dry contact match zones check box, and the dry port output corresponds one-to-one 

with the zones. For example, the Zone 1 runs the Port 1 enables. The function is used for volume 

controller  

• Editing Play Task 

Select one play task in the task list, and click  icon in the upper right corner of the task list or 

double left click, the Edit window is displayed. The user can edit the parameters like those above 

as needed.  

• Deleting play task 

Select one play task in the task list, and click  icon in the upper right corner of the task list, the 

deleting confirmation window is displayed, and click YES to delete that task. 

Users can also add, copy, paste, edit and delete the tasks through right-click in the task list. 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

3． Task Serial 

When the more complex operation, which enables multiple tasks to play with one trigger, through 

the dry contacts, is needed, the users can set the task serial. The task serial contains many tasks 

is triggered, the tasks will follow respective play policies to run. As shown below: 

 

• Task List 

The task list displays all of the tasks in current setting, includes task name and type. 

• Serial List 

The serial list displays the task serials have already existed, and provides the Add, Edit and Delete 

operation. 

Click  icon in the upper right corner of the serial list, and the Add window is displayed as below: 

 

Enter the serial name and click OK button.  

Select one task serial in the serial list, and click  icon in the upper right corner of the task list or 

double left click, the Edit window is displayed. The user can edit the serial name as needed.  

Select one task serial in the serial list, and click  icon in the upper right corner of the task list, 

the deleting confirmation window is displayed, and click YES to delete it. 

 

 

 

 

 



 

 

• Serial Detail 

Select some task serial, all the tasks of that serial list would be displayed in the Serial Detail view. 

Left click and drag the tasks in the Task List into the Serial Detail view, and the tasks have been 

added in the serial list. 

If the users want to delete the tasks, select them can click  icon or right-click them and click 

Delete from the pop- up menu.  

Operation Settings 

Operation setting is used to set the tasks for the DCS key, PTT, contact input and timing operation.   

1． Operation 

  

• Key List 

Key List is used to set the tasks for manual operation by the X-DCS2000/EN key or PTT.  

Click the Key1~Key4 or PTT respectively corresponding task cells, and select the tasks have been 

configured in the phase of Task. Normal PTT and Emergency PTT can only select the tasks which 

selected PTT as audio source; the software will filter them automatically. 

➢ Key 1~Key 4 respectively correspond to the 4 sound source selection buttons on the X-

DCS2000/EN front panel. 

➢ Normal PTT corresponds to the X-DCS2000/EN PTT operation in the normal state.  The 

task has to be selected those set the PTT as audio source and normal as the task type. 

➢ Emergency PTT corresponds to the X-DCS2000/EN PTT operation in the emergency 

state.  The task has to be selected those set the PTT as audio source and Emergency as 

the task type. 

• Contact Input List 

There are 2 types of dry contact input on the DCS: Physical and Virtual. 

➢ Physical dry contact input is the signal which is sent from corresponding physical ports on 

the device. 

➢ Virtual dry contact input is the signal which is set through the system inner software for 

operation convenience, and it can be applied to linkage control, for example links with 

FAS system according to LPI-ModBus. If the fire alarm interface is Net-NRI, the 

evacuation tasks and alert tasks of the each DCS corresponding virtual dry contacts can 

be set in the section of NRI Task Setting. 

Only one task or task serial can be selected for each contact input port.  

 

 

 

 



 

 

2． Timing  

The timing broadcast function can be set through the configure software, and DCS can work 

automatically according to the pre-established timing. The timing setting includes Daily, Weekly 

and Special. The daily timing is the foundation of the timing function, but it can’t be executed 

directly. Before configuring any timing schedule, create a daily schedule first. Then use the daily 

schedule to configure the weekly and special schedules as needed. 

 

• Daily 

Each X-DCS2000/EN can set up to14 daily schedules. Click one cell of the Day Timing List, and 

enter the schedule name. And then click the corresponding Start Time, End Time and Task to set 

the detailed contents of the timing in the Day Timing Contents. Each daily schedule can set 40 

timing contents at most. 

  Note: 

Make sure the daily timing was set within 24 hours, and the End time must be at least 5 seconds 

after start time. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

• Weekly 

Click Weekly and the setting view would be displayed. Select a daily timing for everyday within a 

week. If the content of one day is empty, means that day has no timing schedule. 

 

• Special 

Special timing is the schedule beyond the weekly timing. For example, set a special play task suits 

the festival atmosphere or rest in a holiday. The priority of special timing is higher than weekly 

timing. If one day is set special timing, then other timing settings are invalid. 

 

X-DCS2000PLUS Settings 

Select the DCS in the Project explorer view, users can configure the following settings by the three 

navigation buttons at the upper left of the view. 

• Device 

- Properties 

- Modules 

- Amplifier 

- Time 

- Supervision 

- AVC 

• Task 

- Play List 

- Task 

- Task serial 



 

 

• Operation 

- Operation 

- Timing 

Device Settings 

The basic function parameters for the X-DCS2000PLUS can be set under this tab. These items 

such as Properties, Modules, Standby, Time, Supervision, and AVC will be set in turn. 

1． Properties 

 “Properties” is used to set the required parameters for the X-DCS2000PLUS to work normally, as 

shown below： 

 

• Basic Setting 

Basic Setting includes Device ID, Device Name, Device Type and Emergency Button. Device ID is 

the only device identification in the system, which ranges from 1 to 999. 

The option “Emergency Button” is to enable or disable emergency button on X-DCS2000PLUS 

front panel. The checkbox shown as  means emergency button is enabled.. 

• Fire Alarm Interface 

This item is used to set the fire alarm interface, including Disabled, Contact inputs, LPI-ModBus, 

Network-NRI. By default it is disabled. 

➢ If users select Contact inputs, the X-DCS2000PLUS contact inputs will receive the fire 

alarm signal directly. To fulfill the fire alarm function, the corresponding tasks of the 

Physical Contact Input List need to be set in the Operation tab. 

➢ If users select LPI-ModBus, the X-DCS2000PLUS can communicate with fire alarm panel 

by LPI-ModBus directly. X-DCS2000PLUS will be in the slave mode at that time, and the 

Slave Address has to be set, which ranges from 1 to 31. For the introduction of LPI-

ModBus module, please refer to LPI-ModBus converter User’s Manual. 

 

 

If users select Network-NRI, the fire alarm control panel should be connected with NRI ports, the 

fire alarm signal will be transmitted to NRI. According to preset linkage, the X-DCS2000PLUS 

emergency voice alarm function is enabled. For corresponding settings, refer to Chapter X-NRI 

Setting. 



 

 

• Network Setting 

Use network setting to set the X-DCS2000PLUS network parameter. Old IP is the IP 

address before setting, and New IP is the IP address after setting. To update network 

parameters of DCS2000PLUS, connect it to a computer with an IP in the same segment 

of the old DCS IP. Click the Update button to set the IP of DCS, the two addresses will 

be identical after being updated successfully. The default IP address is 192.168.2.200. In 

case users forget the specified IP address, the default IP address can be obtained by 

pressing the appropriate button to reset the IP address.  

Note: Network parameter is excluded in configuration files. Downloading configuration won’t 

change network configuration, which can only be changed by updates. While operating, please 

make sure device is connected to the network and the network settings are correct. 

• Virtual DCS 

Virtual DCS is used to integrate with the third-party system and won’t be displayed in download 

window. 

• Zone List 

The Zone List setting function allows users to enable/disable the zones and set the Zone Name 

and Power. Click the check box shown as  to enable the corresponding zone. 

And  shows the zone is disabled. Click directly one zone name or power in the zone list to edit 

it. The power setting value is only used to determine if the amplifiers are appropriate. The output 

volume corresponding to loudspeaker lines in emergency can be set, and the ranges are from -

10dB to 0dB.  Zones’ default broadcast volume can be set in “Emergency Volume”, which ranges 

from -10dB to 0dB. The minimum volume set at -10dB to avoid the audio volume from being too 

low while in emergency broadcasting. Power value in the zone list can’t represent anything and 

only record the actual power rate. 

Select one zone and click the  icon on the right of the Zone List, the rest of power can be set 

as same as the selected zones. Therefore the same power value can be applied to all zones 

quickly. 

• Audio Input Setting 

Audio Input Setting is used to set the parameter of auxiliary input audio, such as enable/disable 

input, multicast IP, audio source, input sensitivity, stoppable and IN dryport. Each row represents 

one audio channel.  Click the check box shown as  to enable the audio channel, and  

means the channel is disabled. After initiating, it will assign multicast IP address for each audio 

channel automatically, and the audio signal will be broadcasted in the network. Users can also 

change the multicast address according to requirements. Default address is recommended. 

Relevant information of audio can be input in the “Audio Source” column. Auxiliary input 2 and 3 

are the balance input interface of XLR. Users can set balance or non-balance signal. Input 

sensitivity can be adjusted from -40dBV~0dBV. 

Note: 

If audio inputs of X-DCS2000PLUS are enabled, device will broadcast input audio source to 

network. To avoid network jam, it is recommended to enable “Stoppable” function so that audio 

flow will synchronize with the task. User can also enable audio source by configuring “IN dryport”.  

“Stoppable” and “IN dryport” can only be enabled based on the following version: V3.9.8 of 

Configuration, V3.2.9 of X-Smart, V3.5.25 of X-NPMK and V3.5.31 of X-NPMS or above. 

• Storage 

Storage is used to set storage location of audio files, including flash memory or SD card. Flash 

memory of 606MB and 4GB SD card are provided. Users can check the current status of storage 

space. 

 



 

 

2． Modules 

External modules on DCL buses can be configured, such as digital noise detector or end-of-line 

module, which should be completely the same as the actual connected modules.  

 

The ports should match the DCL ports on the rear panel of X-DCS2000PLUS.  The module types, 

such as noise detector or line detector need to be set according to actual address of every input 

channel.  

 

3． Amplifier 

“Amplifier” is used to set the backup amplifier function.  

 

• Backup Amplifier Setup  

Includes disable, single mode and double mode, the default is disable.  

- Disable: No backup function. 

- Single mode: Only one amplifier channel which is connected with SPARE1 can back up 8 

amplifiers at most. 

-Double mode: Two amplifier channels can be connected for backup. The first channel is used to 

backup CH1 CH3, CH5 and CH7 main amplifiers, and the second is used to backup CH2, CH4, 

CH6 and CH8 main amplifiers. 

Spare Channel: set the spare amplifier model at spare CH1 and CH2. 

• Main Amplifier Setting 

It is used to set the main amplifier model, backup and recovery. The amplifier supervision should 

be enabled, otherwise the backup function won’t work normally. 

• Relation of Amplifier Channels and Zones 

Users need to set the relation of amplifier channels and zones, the setting mode can be one to one 

or one to more. Note: the spare mode can affect the relation of amplifier channels and zones. 



 

 

4． Time 

"Time” is used to set the time parameters of X-DCS3000, as shown below: 

 

• “Synchronization Mode” is to set the parameters of time synchronization for DCS through NTP 

protocol. Default setting is off. 

➢ If NTP Server is enabled, DCS will work as a time server, all devices synchronize the 

time with it. In other words, all devices’ time conforms with the time of DCS.. 

➢ If NTP Client is enabled, DCS automatically synchronizes the time via a time server, 

the server IP address and synchronization period must be set beforehand. 

• “Time Zone Setting” is used to set internal time zone of X-DCS2000PLUS. Choose the time 

zone of current location and click “Update” button to change the time zone of X-

DCS2000PLUS, if “All Devices” is selected, clicking “Update” will change the time zone of all 

devices. If the device time zone is different from the local time zone, the time and date will be 

wrong during time synchronization.    

•  “Date & Time Setting” is used to view and manually update the device’s date and time. Click 

“Get” button to read the device’s date & date. If users only click “Update” button, the time and 

date of current DCS is updated. If users click “All Devices” and then click “Update” button, the 

time and date of all device, such as X-DCS2000/EN, X-DCS2000PLUS, X-DCS3000, X-NPMS, 

X-NPMIC and X-NRI, will be updated. 

  Note: 

If firmware version of X-DCS2000PLUS is V3.5.2 or above, users need to input device passport 

when read or edit Time Zone Setting. The default password is hon12345. 

 

 

 

 

 

 

 

 



 

 

5． Supervision 

“Supervision” is used to enable or disable the supervision functions, and requisite parameters for 

check are shown as below： 

 

• Supervision Options 

Through the software, users can set the fault supervision for the AC Power, DC Power, 

Communication and Speaker Line enabled/disabled. 

• Line Supervision Setting 

If Line impedance is enabled, users can respectively enable/disable the line supervision function of 

the enabled speaker lines and set the line tolerance parameters. When the line impedance is lower 

than the lower limit, a short circuit will be found in the speaker line. When the impedance is higher 

than upper limit, an open circuit will be found in the speaker line. Here the unit of impedance 

tolerance is “%”. The default monitoring type is line impedance. If end-of-line modules is used,, 

EOL monitoring should also be selected. 

Select a line and click the  icon on the right of the Line Supervision Setting list, the rest of 

parameters can be set accordingly. 

• Modules Supervision 

The modules connected with X-EOL or digital noise detector X-ND100 can be supervised. The 

check-boxes are used to enable or disable line supervision. Check box which shown as  

means enable, and  means disable. 

• Line Check Interval Time 

This item is used to set the measurement period of speaker line impedance. The value ranges 

from 10 to 1800s.  

• Dry Contact Input Supervision 

If the dry contact inputs are connected with the third-party devices, the transmission line can be 

supervised. This function is configurable. Every line of the device should be installed with 10K 

ohmic resistances to make sure the detection correct. 

 

 

 

 



 

 

• Amplifier Supervision 

Device fault and loop fault of amplifier can be set separately. Device fault means the fault of 

amplifier device, such as power fault or protection. Loop fault describes audio signal transit to 

amplifier from DCS, and back to DCS after amplifying, the audio can’t be played due to the loop or 

device fault. Check box which shown as  means enable, and  means disable. If the actual 

use of amplifier is two channels or four channels, channel number in odd, such as No. 1, 3, 5,etc 

should be enabled during the device fault setting. Channel number in even mustn’t be selected, 

otherwise the supervision will be incorrect. 

6． AVC 

The AVC Setting function allows users to set the parameters for the AVC, as shown below: 

 

• AVC Input 

Select the AVC input channel, which should match the input channel that in supervision module, 

and check the box to enable the AVC function of the selected channel. If channel is not equipped 

with noise detector, it can’t be selected. 

“Calculation” means when there are many noise detectors in one line, the device can automatically 

volume control (AVC) according to average or maximum value.    

• AVC Parameter Setting 

➢ “Sampling Period” is the supervision cycle of ambient noise. Its setting range is related to 

the number of connected modules of device. 

➢ “Sensor Deviation” means the deviation between the actual sound pressure level and the 

one measured by noise detector. Actual sound pressure can be measured by the sound 

pressure meter. Constant audio signal, such as white noise and sine wave can be played 

during the commissioning. Then the deviation can be obtained through measurement of 

the device and sound pressure meter. Any interference is forbidden during the 

measurement. 

➢ “Reaction Level” with the unit of dB is the bound value to enable the AVC function. When 

the sound pressure is equal or greater than this value, AVC function is enabled to adjust 

output volume automatically. When it is less than the bound value, the output volume is 

the minimum value. 

➢ The “Level deviation (min)” is used to set the minimum volume of the adjusting range. 

➢ The “Level deviation (max)” is used to set the maximum volume , which can be adjusted 

through the AVC. 



 

 

➢ “Factor” provides the function to set the volume adjusting ratio, same philosophy to sound 

change. The bigger the adjusted ratio, the bigger the volume change. 

➢ “Action Threshold” is the variation value more than last ambient noise collection. Only the 

current collection value is greater than last, volume can be adjusted. The smaller the 

parameter is, the more sensitive AVC is. 

➢ “SNR” means the lowest signal noise ratio between the broadcast and the ambient noise.  

Broadcast volume calculation formula: 

Output Volume= (Ambient Noise+ Sensor Deviation- Reaction Level) X Factor+ Level 

deviation (min) 

• Controlled Lines 

“Controlled Lines Setting” means the zones that are controlled by AVC, select the zone through the 

check box.  

• “Calib. AVC Module” and “Calib. Reaction Level” Button 

“Calib. AVC Module” is used to calibrate broadcast signal from digital noise detector X-ND100 

under on-line condition. During calibration, X-DCS3000 will automatically broadcast periodic pulse 

signal, therefore, digital noise detector can compare the signal from loudspeaker lines with the 

signal from microphone to improve accuracy of noise measurement. 

“Calib. Reaction Level” is to automatically set parameter of “Reaction Level”. When it is enabled, 

device-DCS3000 will automatically broadcast noise signal at maximum volume and collect noise 

signal through digital noise detector. It will calculate recommended “Reaction Level” for users 

according to “minimum volume” and “SNR”. During this procedure, configuration software will 

broadcast noise signal to targeted zones, users shall select the network adaptor which is 

connected with X-618 system. 

• Read Data 

During the AVC settings, enable the read data function by selecting the check box. Information like 

measured value of ambient noise, actual value of ambient noise, adjustment bound value, reaction 

level, broadcast output volume, working status, last action time and module data can be shown. 

Task Settings 

Task Setting is mainly used to set the necessary task for the broadcasting by the X-

DCS2000PLUS. Each task includes audio library, play policy, zone setting and dry contact to fulfill 

all the play operations. 

Task setting includes Play List, Task and Task serial. 

1. Play List 

Play List is used to set the audio source and the play lists for the play tasks, as shown below: 

 



 

 

• Library 

The users have to configure the audio library first, if users want to play the audio files in the system. 

All the audio files’ basic messages, such as file name, size and length,  will be shown in the audio 

library. And the total size can be obtained at the top of the Library. X-DCS2000PLUS will share the 

audio library with X-DCS2000/EN, X-DCS3000, X-NPMI, X-NPMS and NRI during configuration. 

The required audio files can be downloaded to the devices through the system. 

Click  icon, the Open window is displayed. The users can find and select one or more audio 

files from PC to add the audio file library. This software supports MP3 and WAV audio formats. The 

other audio formats can be converted automatically to the audio format as system needed. 

Select one or more audio files, click   icon, the selected ones can be deleted from the library list. 

If the audio file that is intended to be deleted has been added into some play list, the information 

window is displayed to show that the file has been used and cannot be deleted. 

By right clicking in the list to display Add and Delete menu, audio files can be added or deleted. 

 

• Play List 

After finishing the library setting, the play list can be created, and classified into two types: Public 

and Private. The public play lists can be used by all the X-DCS2000/EN, X-DCS2000PLUS, X-

DCS3000, X-NPMI and X-NPMS. And the private ones just for current X-DCS3000.  

Click the  icon in the Play List view, the Add window is displayed as below: 

Enter the play list name, select the type from the drop - down menu, and click OK to create a new 

play list. 

Select one play list and click  icon or double-click the list, the Edit window for editing the play 

list name as needed, is displayed as below: 

 

Select some playlists in the Play List view click  icon to delete them. 

By right clicking in the list to display Add and Delete menu, audio files can be added or deleted. 

 

 

 

 



 

 

• Contents 

Select some play list, then all the audio files of that list will be displayed in the Contents view. Left 

click and drag the audio files in the library into the Contents view, and the audio files have been 

added in the play list. 

The user can reorder the audio files as needed: 

➢ Click  icon to move forward the selected audio file. 

➢ Click  icon to move backward the selected audio file. 

➢ Click  icon to delete the selected audio file. 

 

2. Task 

Task is used to view, add, modify and delete broadcast task, as shown below: 

 

• Task List 

Many parameters of the all tasks are displayed in the task list, such as task name, type, audio 

source, zones, dry contact, priority, loop, delay, recovery, and audition, busy wait, full and record. 

• Adding Play Task  

Click  icon in the upper right corner of the task list, and the window is displayed as below: 

 

 

 



 

 

Set the following parameters as needed: 

a.    Task: enter the task’s name to identify the task’s effect. 

b. Type: Normal or Emergency.  

➢ Normal is used for the public address such as the normal background music, 

operation broadcast, voice broadcast etc. The priority range is 56~255. 

➢ Emergency is used for the fire emergency broadcast. The priority range is 1~55. 

Audio Type: Play List and Net Audio. 

➢ Play List: usually used for voice broadcast, background music etc. Users also can add 

the prompt tone files into the play list as needed. 

➢ Net Audio: Mainly external audio sources connected through NRI or X-DCS3000 inner 

or external voice, which can be selected through the drop - down menu. 

c. Policy: 

➢  Delay: Edit this field to specify a time in the range of 0~600 seconds for which the 

audio is delayed before being played. 

➢ Priority: The range of the value is different based on different task type. The Normal 

and Emergency task values must be between 56 ~ 255 and 1 ~ 55 respectively. If 

many play tasks are set to broadcast to the same zones simultaneously, the highest 

priority one will be played. The smaller the value is, the higher the priority.  

➢ Loop: This item is available only to that selected audio type being play list or record 

file. It is used to set the play times in the range of 1~65535. 

➢ Forever: Enable/disable forever loop playback. 

➢ Preview: Check the check box or not to enable/disable the function which supports 

confirmation of the play contents according to auditioning them by the device’s built-

in speakers in advance. 

➢ Busy wait: click the check box to enable the lower priority task which is in conflict with 

an ongoing. Otherwise once the previous task is over, the lower priority one will be 

cancelled automatically.. 

➢ Resume: Enable or disable the shortcut task which is broken off by the higher priority 

task resumes automatically when the insert task is over. 

➢ Full: Mainly used in emergency broadcast to keep integrality of the new added task 

that comes from the same audio source and play policy. If the check box is selected, 

the two combined tasks will be broadcasted from the beginning after the waiting 

audio and vice versa. 

d. Zones: Select the appropriate broadcast zones. Because tasks configured for X-DCS3000 

only can be broadcasted in the local zones, at most 8 zones can be selected. Click  to 

select all, and click  to cancel all. 

e. Dry Contact: Check the dry contact match zones check box, and the dry port output 
corresponds one-to-one with the zones. For example, the Zone 1 runs the Port 1 enables. 
The function is used for volume controller  

• Editing Play Task 

Select one play task in the task list, and click  icon in the upper right corner of the task list 

or double left click, the Edit window is displayed. The user can edit the parameters like those 

above as needed.  

• Deleting play task 

Select one play task in the task list, and click  icon in the upper right corner of the task list, 

the deleting confirmation window is displayed, and click YES to delete that task. 



 

 

 

 

3. Task Serial 

When more complex operations that enable multiple tasks to be run by one trigger through dry 

contacts are needed. Users can set the task serial. The task serial contains many tasks, 

once it is triggered, tasks will be run following respective policies. As shown below: 

 

• Task List 

The task list displays all of the tasks in current setting, including task name and type. 

• Serial List 

The serial list displays the task serials that already existed, and provides the Add, Edit and Delete 

operation. 

                       Click  icon in the upper right corner of the serial list, and the Add window is displayed as below: 

                        

Enter the serial name and click OK button.  

Select one task serial in the serial list, and click  icon in the upper right corner of the task list or 

double left click, the Edit window is displayed. The user can edit the serial name as needed.  

Select one task serial in the serial list, and click  icon in the upper right corner of the task list, 

the deleting confirmation window is displayed, and click YES to delete it. 



 

 

 

• Serial Detail 

Select some task serial, all the tasks of that serial list will be displayed in the Serial Detail view. Left 

click and drag the tasks in the Task List into the Serial Detail view, and the tasks have been added 

in the serial list. 

If users want to delete the tasks, select them can click  icon or right-click them and click Delete 

from the pop-up menu.  

Operation Setting 

Operation setting is used to set the tasks for the X-DCS2000PLUS keys, contact inputs and timing 

operation.   

1. Operation 

  

• Key List 

Key List is used to set the tasks for manual operation by the X-DCS2000PLUS keys. 

➢ Key 1~Key 4 respectively correspond to the 4 sound source selection buttons on the X-

DCS2000PLUS front panel. 

Click the Key1~Key4 respectively corresponding task cells, and select the tasks that have been 

configured in the phase of Task. 

  Note: 

Users cannot choose stoppable task. 

 

 

 

 

 



 

 

• Contact Input List 

Two types of dry contact inputs are available on DCS: Physical and Virtual. 

➢ Physical dry contact input is the signal sent from corresponding physical ports on the 

device. 

➢ Virtual dry contact input is the signal set through the system inner software for operation 

convenience, and it can be applied to linkage control, for example links with FAS system 

according to LPI-ModBus. If the fire alarm interface is Net-NRI, the evacuation tasks and 

alert tasks of each X-DCS2000PLUS corresponding virtual dry contacts can be set in the 

section of NRI Task Setting. 

 

Only one task or task serial can be selected for each contact input port. The steps are as follows: 

a. Check the Enable check box as needed. 

b. Each port corresponds to a task cell, when click, provides a drop-down menu with a 

list of selectable task or task serial options. 

c. Select one task or task serial as needed. 

• Device Status Output 

Dry contact output can be set as “General Fault Output” or “Fire Status Output”. 

When a dry contact output is set as “General Fault Output”, usually the port is in open status. If the 

DCS finds any fault, this port will be closed to transit the fault status to the third-party device. 

When a dry contact output is set as “Fire Status Output”, usually the port is in open status. If DCS 

enters emergency mode, this port will be closed to transit the fire alarm signal to the third device.  

2. Timing  

The timing broadcast function can be set through the configuration software, and X-

DCS2000PLUS can broadcast automatically according to the timing setting. The timing setting 

includes Daily, Weekly and Special. The daily timing is the foundation of the timing function, but it 

can’t be executed directly. Before configuring any timing schedule, create a daily schedule first. 

Then use the daily schedule to configure the weekly and special schedules as needed. 

  

• Daily 

Each X-DCS2000PLUS can set up to 14 daily schedules. Click one cell of the Day Timing List, and 

enter the schedule name. And then click the corresponding Start Time, End Time and Task to set 

the detailed contents of the timing in the Day Timing Contents. At most 40 timing contents can be 

set for each daily schedule. 



 

 

  Note: 

Make sure the daily timing is set within 24 hours, and the end time must be at least 5 seconds after 

start time. 

 

• Weekly 

Click Weekly and the setting view is displayed. Select a daily timing for everyday within a week. If 

the content of one day is empty, that day has no timing schedule. 

 

• Special 

Apart from weekly timing, special timing is used for exceptional schedule.  For example, set a 

special play task to suit a festival occasion or holiday occasion. To set special timing, do the 

following: select the Start Date, End Date and Day Program one by one. If users want to delete 

one item, select it and click  icon. 

 

 

  Note:  

This timing setting is used in the internal timing broadcast for only one DCS. For multiple DCSs in 

system, voices that are out of sync will occur when broadcasting DCS internal audios due to time 

difference of devices.  

 



 

 

X-DCS3000 Settings 

Select the DCS in the Project explorer view, users can configure the following settings by the three 

navigation buttons at the top left of the view. 

• Device 

- Properties 

- Modules 

- Amplifier 

- Time 

- Supervision 

- AVC 

• Task 

- Play List 

- Task 

- Task serial 

• Operation 

- Operation 

- Timing 

Device Settings 

 The basic function parameters for the X-DCS3000 can be set under this tab. These items such as 

Properties, Modules, Standby, Time, Supervision, and AVC will be set in turn. 

1． Properties 

 “Properties” is used to set the requisite parameters for the X-DCS3000 working normally, as 

shown below： 

  

• Basic Setting 

Basic Setting includes Device ID, Device Name, Device Type and Emergency Button. Device ID is 

the only device identification in the system, which in the range of 1~999. 



 

 

The option “Emergency Button” is to enable or disable emergency button on X-DCS3000 front 

panel. The checkbox shown as  means enabled. 

• Fire Alarm Interface 

This item is used to set the fire alarm interface, including Disabled, Contact inputs, LPI-ModBus, 

Network-NRI. The default setting is disabled. 

➢ If select Contact inputs, the X-DCS3000 contact inputs will receive the fire alarm signal 

directly. To fulfill the fire alarm function, the corresponding tasks of the Physical Contact 

Input List need to be set in the Operation tab. 

➢ If select LPI-ModBus, the X-DCS3000 can communicate with fire alarm panel by LPI-

ModBus directly. X-DCS3000 shall be in the slave mode at that time, and the Slave 

Address has to be set, and the range is 1~31. The introduction of LPI-ModBus module, 

please refer to LPI-ModBus converter User’s Manual. 

 

If select Network-NRI, the fire alarm control panel should be connected with NRI ports, the fire 

alarm signal will be transmitted to NRI, and according to the preset linkage relationship to enabled 

the X-DCS3000 emergency voice alarm function. The corresponding settings please refer to the 

section of NRI Setting in this manual. 

• Network Setting 

Use to set the X-DCS3000 network parameter. Old IP is the IP address before setting, and New IP 

is the IP address after setting. For updating the network parameters of the system devices, it shall 

be connected to computer whose IP should be in the same segment with the old IP of DCS. Click 

the Update button for setting the IP of DCS, the two IP address would be the same after updating 

successfully. The default IP address is 192.168.2.200. If the specified IP address has been 

forgotten, the default IP address can be obtained by pressing the appropriate button to reset the IP 

address. 

Note: Network parameter is excluded in configuration files. Downloading configuration won’t 

change network configuration, which can be only changed by updating. While operating, please 

make sure device is connected to the network and the network settings are correct. 

• Virtual DCS 

Virtual DCS is used to integrate with the third-party system and won’t be displayed in download 

window. 

• Zone List 

The Zone List setting function allows users to enable/disable the zones and set the Zone Name 

and Power. Check the check box shown as  to enable the corresponding zone. 

And   shows the zone is disabled. Click directly one zone name or power in the zone list to edit 

it. The power setting value is only used to determine if the amplifiers are appropriate. The output 

volume corresponding to loudspeaker lines in emergency can be set, and the ranges are from -

10dB to 0dB.  Zones’ default broadcast volume can be set in “Emergency Volume”, which ranges 

from -10dB~0dB. The minimum volume is -10dB to avoid the audio volume from too low while 

emergency broadcasting. Power value in the zone list can’t represent anything and only record the 

actual power rate. 

Select one zone, and click the icon in the right of the Zone List, the rest of power can be set 

as the same as the selected zone’s. So the same power value will be set for all the zones quickly.  

• Audio Input Setting 

Audio Input Setting is used to set the parameter of auxiliary input audio, such as enable/disable 

input, multicast IP, audio source, input sensitivity, stoppable and IN dryport. Each row represents 

one audio channel.  Check the check box shown as  to enable the audio channel, and  

means the channel is disabled. After initiating, it will assign multicast IP addresses for each audio 

channel automatically, and the audio signal will be broadcasted in the network. Users can also 

change the multicast addresses according to requirements. Default address are recommended. 



 

 

Relevant information of audio can be input in the “Audio Source” column. Auxiliary input 2 and 3 

are the balance input interface of XLR. Users can set balance or non-balance signal. Input 

sensitivity can be adjusted from -40dBV to 0dBV. 

Note: 

If audio inputs of X-DCS3000 are enabled, device will broadcast input audio source to network. To 

avoid network jam, it is recommended to enable “Stoppable” function so that audio flow will 

synchronize with the task. User can also enable audio source by configuring “IN dryport”.  

“Stoppable” and “IN dryport” can be only enabled based on the following version: V3.9.8 of 

Configuration, V3.2.9 of X-Smart, V3.5.25 of X-NPMK and V3.5.31 of X-NPMS or above. 

• Storage 

Storage is used to set storage location of audio files, including flash memory or SD card. Flash 

memory of 606MB and 4GB SD card are provided. Users can also check the current status of 

storage space. 

 

2． Modules 

External modules on DCL buses can be configured, such as digital noise detector or end-of-line 

module, which should be completely the same as the actual connected modules.  

 

The ports should be matched the DCL ports on the rear panel of X-DCS3000.  The module types, 

such as noise detector or line detector are needed to be set according to actual address of every 

input channel.  

 

3． Amplifier 

“Amplifier” is used to set the backup amplifier function.  

 



 

 

• Backup Amplifier Setup  

Includes disable, single mode and double mode, the default is disable.  

- Disable: No backup function. 

- Single mode: Only one amplifier channel which is connected with SPARE1 can back up 8 

amplifiers at most. 

-Double mode: Two amplifier channels can be connected for backup. The first channel is used to 

backup CH1 CH3, CH5 and CH7 main amplifiers, and the second is used to backup CH2, CH4, 

CH6 and CH8 main amplifiers. 

Spare Channel: set the spare amplifier model at spare CH1 and CH2. 

• Main Amplifier Setting 

It is used to set the main amplifier model, backup and recovery. The amplifier supervision should 

be enabled, otherwise the backup function won’t work normally. 

• Relation of Amplifier Channels and Zones 

Users need to set the relation of amplifier channels and zones, the setting mode can be one to one 

or one to more. Note: the spare mode can affect the relation of amplifier channels and zones. 

 

4． Time 

"Time” is used to set the time parameters of X-DCS3000, as shown below: 

 

• “Synchronization Mode” is to set the parameters of time synchronization for DCS through NTP 

protocol. Default setting is off. 

➢ If NTP Server is enabled, DCS will work as a time server, all devices synchronize the 

time with it. In other words, all devices’ time would be in conformance with the DCS’s. 

➢ If NTP Client is enabled, DCS automatically synchronizes the time via a time server, 

the server IP address and synchronization period should be set. 

• “Time Zone Setting” is used to set internal time zone of X-DCS3000. Choose the time zone of 

current location, and click “Update” button to change the time zone of X-DCS3000, if “All 

Devices” is selected, click “Update” will change the time zone of all devices. If the device time 

zone is different from the local time zone, the time and date will be wrong while time 

synchronization.  

•  “Date & Time Setting” is used to view and manually update the device’s date and time. Click 

“Get” button to read the device’s date & date. If only click “Update” button, the time and date of 



 

 

current DCS will changed. If select “All Devices” and click “Update” button, the time and date 

of all device, such as X-DCS2000/EN, X-DCS3000, X-NPMS, X-NPMIC and X-NRI, will be 

changed. 

  Note: 

If firmware version of X-DCS3000 is V3.5.2 or above, users need to input device passport when 

read or edit Time Zone Setting. The default password is hon12345. 

 

5． Supervision 

“Supervision” is used to enable or disable the supervision functions, and the requisite parameter 

for check as shown below： 

 

• Supervision Options 

Through the software, users can set the fault supervision for the AC Power, DC Power, 

Communication and Speaker Line enabled/disabled. 

• Line Supervision Setting 

If Line impedance is enabled, users can respectively enable/disable the line supervision function of 

the enabled speaker lines and set the line tolerance parameters. When the line impedance is lower 

than the lower limit, a short circuit will be found in the speaker line. When the impedance is higher 

than upper limit, an open circuit will be found in the speaker line. Here the unit of impedance 

tolerance is “%”. The default monitoring type is line impedance. If using end-of-line modules, EOL 

monitoring should also be selected. 

Select a line, and click the  icon in the right of the Line Supervision Setting list, the rest of 

parameters can be set as the same as the selected one’s. 

• Modules Supervision 

The modules connected with X-EOL or digital noise detector X-ND100 can be supervised. The 

check-boxes are used to enable or disable line supervision. Check box which shown as  

means enable, and  means disable. 

 

 



 

 

• Line Check Interval Time 

This item is used to set the measurement period of speaker line impedance. The value ranges 

from 10~1800s.  

• Dry Contact Input Supervision 

If the dry contact inputs are connected with the third-party devices, the transmission line can be 

supervised. This function can be configurable. Every line of the device should be installed with 10K 

ohmic resistances to make sure the detection correct. 

• Amplifier Supervision 

Device fault and loop fault of amplifier can be set separately. Device fault means the fault of 

amplifier device, such as power fault or protection. Loop fault describes audio signal transit to 

amplifier from DCS, and back to DCS after amplifying, the audio can’t be played due to the loop or 

device fault. Check box which shown as  means enable, and  means disable. If the actual 

use of amplifier is two channels or four channels, channel number in odd, such as No. 1, 3, 5,etc 

should be enabled during the device fault setting. Channel number in even can’t be selected, 

otherwise the supervision will be incorrect. 

 

6． AVC 

The AVC Setting function allows users to set the parameters for the AVC, as shown below: 

 

• AVC Input 

Select the AVC input channel, which should be matched with that in supervision module, and 

check the box to enable the AVC function of the selected channel. If channel is not equipped with 

noise detector, it can’t be selected. 

“Calculation” describes when there are many noise detectors in one line, the device can 

automatically volume control (AVC) according to average or maximum value.    

• AVC Parameter Setting 

➢ “Sampling Period” is the supervision cycle of ambient noise. Its setting range is related to 

the No. of connected modules of device. 

➢ “Sensor Deviation” means the deviation between the actual sound pressure level and the 

one measured by noise detector. Actual sound pressure can be measured by the sound 

pressure meter. Constant audio signal, such as white noise and sine wave can be played 

during the commissioning. Then the deviation can be got through measuring by the 

device and sound pressure meter. Any interference is forbidden during the measurement. 



 

 

➢ “Reaction Level” with the unit of dB is the bound value to enable the AVC function. When 

the sound pressure is equal or greater than this value, AVC function is enabled to adjust 

output volume automatically. When it is less than the bound value, the output volume is 

the minimum value. 

➢ The “Level deviation (min)” is used to set the minimum volume of the adjusting range. 

➢ The “Level deviation (max)” is used to set the maximum volume can be adjusted through 

the AVC. 

➢ “Factor” provides the function to set the volume adjusting ratio, same kind of sound 

change, the bigger the adjusted ratio, the bigger the volume change. 

➢ “Action Threshold” is the variation value more than last ambient noise collection. Only the 

current collection value is greater than last, volume can be adjusted. The smaller the 

parameter is, the more sensitive AVC is. 

➢ “SNR” means the lowest signal noise ratio between the broadcast and the ambient noise.  

Broadcast volume calculation formula: 

Output Volume= (Ambient Noise+ Sensor Deviation- Reaction Level) X Factor+ Level 

deviation (min) 

• Controlled Lines 

“Controlled Lines Setting” means the zones that controlled by AVC, select the zone through the 

check box.  

• “Calib. AVC Module” and “Calib. Reaction Level” Button 

“Calib. AVC Module” is used to calibrate broadcast signal from digital noise detector X-ND100 

under on-line condition. During calibration, X-DCS3000 will automatically broadcast periodic pulse 

signal, therefore, digital noise detector can compare the signal from loudspeaker lines with the 

signal from microphone to improve accuracy of noise measurement. 

“Calib. Reaction Level” is to automatically set parameter of “Reaction Level”. When it is enabled, 

device-DCS3000 will automatically broadcast noise signal at maximum volume and collect noise 

signal through digital noise detector. It will calculate recommended “Reaction Level” for users 

according to “minimum volume” and “SNR”. During this procedure, configuration software will 

broadcast noise signal to targeted zones, users shall select the network adaptor which is 

connected with X-618 system. 

• Read Data 

During the AVC settings, enable the read data function by selecting the check box. Information like 

measured value of ambient noise, actual value of ambient noise, adjustment bound value, reaction 

level, broadcast output volume, working status, last action time and module data can be shown. 

Task Settings 

Task mainly used to set the necessary task for the broadcast by the X-DCS3000. Each task 

includes audio library, play policy, zone setting and dry contact to fulfill all the play operations. 

Task setting includes Play List, Task and Task serial. 

1. Play List 

Play List is used to set the audio source and the play lists for the play tasks, as shown below: 



 

 

 

• Library 

The users have to configure the audio library first, if they want to play the audio files in the system. 

All the audio files’ basic messages, such as file name, size and length,  will be shown in the audio 

library. And the total size can be gotten in the top of the Library. X-DCS3000 would share the audio 

library with X-DCS2000/EN, X-DCS2000PLUS, X-NPMI, X-NPMS and NRI during configuration. 

And the required audio files can be downloaded to the devices through the system. 

Click  icon, the Open window is displayed. And the users can find and select one or more audio 

files from PC to add the audio file library. This software supports MP3 and WAV audio formats. 

And the other audio formats can be converted automatically to the audio format as system needed. 

Select one or more audio files, click   icon, the selected ones can be deleted from the library list. 

If the audio file wants to be deleted has added into some play list, the information window would be 

displayed to show that the file has been used, cannot be deleted. 

Right click in the list for Add and Delete menu also can do the audio files addition or deletion 

operation. 

 

• Play List 

After finishing the library setting, the play list can be created, and classified into two types:  Public 

and Private. The public play lists can be used by all the X-DCS2000/EN, X-DCS2000PLUS, X-

DCS3000, X-NPMI and X-NPMS. And the private ones just for current X-DCS3000.  

Click the  icon in the Play List view, the Add window is displayed as below: 

Enter the play list name, select the type from the drop - down menu, and click OK to create a new 

play list. 

Select one play list and click  icon or double-click the list, the Edit window for editing the play 

list name as needed, is displayed as below: 



 

 

 

Select some playlists in the Play List view click  icon to delete them. 

Right click in the list for Add Edit and Delete menu also can do the play list addition, edit or deletion 

operation. 

 

 

• Contents 

Select some play list, the all the audio files of that list would be displayed in the Contents view. Left 

click and drag the audio files in the library into the Contents view, and the audio files have been 

added in the play list. 

The user can reorder the audio files as needed: 

➢ Click  icon to move forward the selected audio file. 

➢ Click  icon to move backward the selected audio file. 

➢ Click  icon to delete the selected audio file. 

 

2. Task 

Task is used to view, add, modify or delete broadcast task, as shown below: 

 

• Task List 

There are many parameters of the all tasks displayed in the task list, such as task name, type, 

audio source, zones, dry contact, priority, loop, delay, recovery, and audition, busy wait, full and 

record. 

• Adding Play Task  

Click  icon in the upper right corner of the task list, and the window is displayed as below: 



 

 

 

 

Set the following parameters as needed: 

a.    Task: enter the task’s name to identify the task’s effect. 

a. Type: Normal or Emergency.  

➢ Normal is used for the public address such as the normal background music, 

operation broadcast, voice broadcast etc. The priority range is 56~255. 

➢ Emergency is used for the fire emergency broadcast. The priority range is 1~55. 

Audio Type: Play List and Net Audio. 

➢ Play List: usually used for voice broadcast, background music etc. The users also can 

add the prompt tone files into the play list as needed. 

➢ Net Audio: Mainly external audio sources connected through NRI or X-DCS3000 inner 

or external voice, which can be selected through the drop - down menu. 

b. Policy: 

➢  Delay: Edit this field to specify a time in the range of 0~600 second for which the 

audio is delayed before being played. 

➢ Priority: The range of the value is different based on different task type. The Normal 

and Emergency task values must be between 56 ~ 255 and 1 ~ 55 respectively. If 

many play tasks are set to broadcast to the same zones simultaneously, the highest 

priority one would be played. And the smaller the value is, the higher the priority.  

➢ Loop: This item is available only to that selected audio type being play list or record 

file. It is used to set the play times in the range is 1~65535. 

➢ Forever: Enable/disable forever loop playback. 

➢ Preview: Check the check box or not to enable/disable the function which supports 

confirming the play contents according to auditioning them by the device’s built-in 

speakers in advance. 



 

 

➢ Busy wait: check the check box to enable the lower priority task which was in conflict 

with a higher priority one plays when the running task finished. Otherwise the task 

would be canceled automatically. 

➢ Resume: Enable or disable the shortcut task which was be broken off by the higher 

priority task resumes automatically when the insert task finished. 

➢ Full: Mainly used in emergency broadcast to keeps integrality of the new added task 

that comes the same audio source and play policy. If the check box is selected, the 

two combined tasks will be broadcasted from the beginning after the waiting audio 

and vice versa. 

c. Zones: Select the appropriate broadcast zones. Because of the tasks configured for X-
DCS3000 only can be broadcasted in the local zones, the most 8 zones can be selected. 

Click  to select all, and click  to cancel all. 

f. Dry Contact: Check the dry contact match zones check box, and the dry port output 
corresponds one-to-one with the zones. For example, the Zone 1 runs the Port 1 enables. 
The function is used for volume controller  

• Editing Play Task 

Select one play task in the task list, and click  icon in the upper right corner of the task list 

or double left click, the Edit window is displayed. The user can edit the parameters like those 

above as needed.  

• Deleting play task 

Select one play task in the task list, and click  icon in the upper right corner of the task list, 

the deleting confirmation window is displayed, and click YES to delete that task. 

 

 

3. Task Serial 

When the more complex operation, which enables multiple tasks to play with one trigger, 

through the dry contacts, is needed, the users can set the task serial. The task serial 

contains many tasks is triggered, the tasks will follow respective play policies to run. As 

shown below: 

 



 

 

• Task List 

The task list displays all of the tasks in current setting, includes task name and type. 

• Serial List 

The serial list displays the task serials have already existed, and provides the Add, Edit and Delete 

operation. 

                       Click  icon in the upper right corner of the serial list, and the Add window is displayed as below: 

                        

Enter the serial name and click OK button.  

Select one task serial in the serial list, and click  icon in the upper right corner of the task list or 

double left click, the Edit window is displayed. The user can edit the serial name as needed.  

Select one task serial in the serial list, and click  icon in the upper right corner of the task list, 

the deleting confirmation window is displayed, and click YES to delete it. 

 

• Serial Detail 

Select some task serial, all the tasks of that serial list would be displayed in the Serial Detail view. 

Left click and drag the tasks in the Task List into the Serial Detail view, and the tasks have been 

added in the serial list. 

If the users want to delete the tasks, select them can click  icon or right-click them and click 

Delete from the pop- up menu.  

Operation Setting 

Operation setting is used to set the tasks for the X-DCS3000 keys, contact inputs and timing 

operation.   

1. Operation 

  



 

 

• Key List 

Key List is used to set the tasks for manual operation by the X-DCS3000 keys. 

➢ Key 1~Key 4 respectively correspond to the 4 sound source selection buttons on the X-

DCS3000 front panel. 

Click the Key1~Key4 respectively corresponding task cells, and select the tasks have been 

configured in the phase of Task. 

  Note: 

Users cannot choose stoppable tasks. 

 

• Contact Input List 

There are 2 types of dry contact input on the DCS: Physical and Virtual. 

➢ Physical dry contact input is the signal which is sent from corresponding physical ports on 

the device. 

➢ Virtual dry contact input is the signal which is set through the system inner software for 

operation convenience, and it can be applied to linkage control, for example links with 

FAS system according to LPI-ModBus. If the fire alarm interface is Net-NRI, the 

evacuation tasks and alert tasks of each X-DCS3000 corresponding virtual dry contacts 

can be set in the section of NRI Task Setting. 

 

Only one task or task serial can be selected for each contact input port. The steps are following: 

d. Check the Enable check box as needed. 

e. Each port respectively corresponding task cell, when click, provides a drop-down 

menu with a list of selectable task or task serial options. 

f. Select one task or task serial as needed. 

• Device Status Output 

Dry contact output can be set as “General Fault Output” or “Fire Status Output”. 

When a dry contact output is set as “General Fault Output”, usually the port is in open status. If the 

DCS finds any fault, this port will be closed to transit the fault status to the third-party device. 

When a dry contact output is set as “Fire Status Output”, usually the port is in open status. If DCS 

enters emergency mode, this port will be closed to transit the fire alarm signal to the third device.  

 

2. Timing  

The timing broadcast function can be set through the configuration software, and X-DCS3000 can 

broadcast automatically according to the timing setting. The timing setting includes Daily, Weekly 

and Special. The daily timing is the foundation of the timing function, but it can’t be executed 

directly. Before configuring any timing schedule, create a daily schedule first. Then use the daily 

schedule to configure the weekly and special schedules as needed. 



 

 

  

• Daily 

Each X-DCS3000 can set up to 14 daily schedules. Click one cell of the Day Timing List, and enter 

the schedule name. And then click the corresponding Start Time, End Time and Task to set the 

detailed contents of the timing in the Day Timing Contents. Each daily schedule can set 40 timing 

contents at most. 

  Note: 

Make sure the daily timing was set within 24 hours, and the End time must be at least 5 seconds 

after start time. 

 

• Weekly 

Click Weekly and the setting view would be displayed. Select a daily timing for everyday within a 

week. If the content of one day is empty, means that day has no timing schedule. 

 

• Special 

Special timing is the schedule beyond the weekly timing. For example, set a special play task suits 

the festival atmosphere or rest in a holiday. The setting steps are simply: select the Start Date, End 



 

 

Date and Day Program one by one. If want to delete one item, just need to select it and click  

icon. 

 

 

  Note:  

This timing setting is used in the internal timing broadcast for only one DCS. For many DCS in 

system, voice that out of sync will occur when broadcast DCS internal audio due to time difference 

of devices.  

 

X-NPMI Settings 

Select an X-NPMI in the Project explorer view, the three navigation buttons in the top left of the 

view will refer users to configure the following settings: 

• Device 

- Properties 

- Devices 

- Groups 

• Task 

- Play List 

- Task 

• Operation 

- Operation 

Device Settings 

The basic function parameter for the X-NPMI can be set under this tab. These items such as 

Properties, Device and Groups will be set in turn. 

1． Properties 

“Properties” is used to set the requisite parameter for the X-NPMI working normally, as shown 

below： 



 

 

 

• Basic Setting 

Basic Setting includes NPM ID, NPM Name, Password, Trigger Type and Emergent button. 

➢ NPM ID is the only device identification in the system, which in the range of 5000~6000. 

➢ Enter a name to mark the device for the convenience of user’s identification. 

➢ Password implements operator authorization management. It can allow nulls. But if a 

password has been set, only the users enter the right password can operate the device. 

 

➢ The Trigger Type can be set to one of the following: 

− Press: Press and hold the TALK button to begin paging, and then release the button 

to release the selected zones and stop paging. 

− Toggle: Press the TALK button a second to begin paging, and then press it again to 

release the selected zones and stop paging. 

➢ The Emergent button is used to set the priority of the NPM. 

➢ Microphone Monitoring is use to enable /disable the microphone fault detection function of 

NPM.  

• Network Setting 

Use to set the X-NPMI network parameter. Old IP is the IP address before setting, and New IP is 

the IP address after setting. For updating the network parameters of the system devices, it shall be 

connected to computer whose IP should be in the same segment with the old IP of NPM.  

After click Update, the IP will update successfully, and the two IP address would be the same. 

The default IP address is 192.168.2.100. The current IP address can be checked and updated by 

screen. 

Note: Network parameter is excluded in configuration files. Downloading configuration can’t fix 

network configuration, which can be only fixed by updating. While operating, please make sure 

device is connected to the network and the network settings are correct. 

• Voice Multicast IP is the IP address when X-NPMI microphone paging. The default address is 

224.0.3.*.  

Note: Voice multicast IP of each X-NPMI should be different, and avoid conflicted with the one of 

X-SMART. 



 

 

2． Devices 

“Devices” is used to select the DCS for operation and the X-NPMI for full duplex intercom, as 

shown below： 

 

• DCS List 

The DCS List displays all the DCS in the system. Check the check box to enable the 

corresponding DCS can be operated through X-NPMI. And then, another click the selected box to 

cancel it. 

• Devices for Intercom 

It displays all the X-NPMI in the system. Check the check box to select the corresponding X-NPMI 

which is wanted to initiate the full duplex intercom function with them. And then, another click the 

selected box to cancel it. 

 

3． Groups 

For user's convenience, there some groups can be set for the X-NPMI through config software. 

Each group can contain many zones. The Groups window is displayed as shown below： 

 

• DCS List & Speaker Line List 

After finishing the DCS List setting in the step of Devices, all of the selected DCS would be 

displayed in the DCS List in this step. Select one DCS, and all zones connected to it would be 

displayed in the Zone List. 

• Group List 

a. First of all, the user has to create a group in the Group List. Click the  icon in the Group 

List view, the Add window is displayed as below: 



 

 

               

Enter the Group Name, and click OK to create a new group. 

b. Select one group and click  icon or double-click the list, the Edit window for editing the 

play list name as needed, is displayed as below: 

               

c. Select one or more groups in the Group List, and then click  icon to delete them. 

Right click in the group list can also add, edit and delete the groups through the menu. 

               

• Group Contents 

Select one group, the all the zones of that group would be displayed in the Zone Detail view. Left 

click and drag the zones into the Group Detail view. And the zones have been added. If left click 

and drag the DCS in the DCS List, all the zones belong to that DCS would be added into the Group 

Detail. 

If users want to delete some zones, only need to select the zones and click  icon to delete them. 

Task Settings 

Task mainly used to set the necessary tasks for the broadcast by the X-NPMI. Each task includes 

audio source, play policy, zone setting and dry contact to fulfill all the play operations. 

Task setting includes Play List and Task.  

1. Play List 

Play List is used to set the audio source and the play lists for the play tasks, as shown below: 

 

• Library 

During the configuration, X-NPMI, X-NPMS and NRI share audio source with X-DCS2000/EN and 

X-DCS3000. The operations to add and delete are the same as operation on X-DCS2000/EN. 



 

 

• Play List  

After finishing the library setting, the play list can be created. In X-NPMI, there is only public play 

list can be used, which shown as below. The operations to add, edit and delete are the same as 

operation on X-DCS2000/EN. 

 

2. Task 

“Task” is used to review, add, edit and delete the broadcast task, which shown as below. For 

operation, please refer to X-DCS2000/EN. 

 

 

Note: Following are the setting differences between X-NPMI and X-DCS2000/EN:  

a. Record and audition are missing.  

b. Operation on X-NPMI requires selecting zones manually.  

c. Zones are not required to set during the X-NPMI configuration. 

The setting window of parameter is shown as below. 

Operation Settings 

Operation mainly used set the tasks which are triggered by the sound sources buttons in the X-

NPMI interface.  

1． Operation 

• Key List-Normal 

In the key list-normal, 4 keys that used in public address and 1 paging key are shown. Select the 

item from the configuration tasks through clicking the key or paging the corresponding broadcast 

task. Paging can be only used for the task which audio source is PTT. Software can filter 

automatically. 

 

• Key List-Emergency 

In the key list-emergency, 4 keys that used in emergency broadcast and 1 paging key are shown. 

Select the item from the configuration tasks through clicking the key or paging the corresponding 

broadcast task. Paging can be only used for the task which audio source is PTT. Software can filter 

automatically. 



 

 

 

X-NPMS Settings 

Select the “X-NPMS V2” in the Project explorer view, the three navigation buttons in the top left of 

the view will refer users to configure the following settings: 

• Device 

- Properties 

- Time 

- Language 

- Supervision 

- Devices 

- Groups 

• Task 

- Play List 

- Task 

• Operation 

- Physical keys 

- One-Click Buttons 

- Manually Broadcast 

- Speech Synthesis 

- Volume Setting 

- User Setting 

Device Settings 

 The basic function parameters for the X-NPMS can be set under this tab. These items such as 

Properties, Time, Language, Supervision, Devices and Groups will be set in turn. 

1． Properties 

 “Properties” is used to set the requisite parameters for the X-NPMS working normally, as shown 

below： 



 

 

 

• Basic Setting 

Basic Setting includes device ID, device name, priority of emergency button, pre-signal, end-signal, 

voice detection and period, line output, multicast channels, first multicast IP, standby time, etc. 

➢ Device ID is the only device identification in the system, which is in the range of 

5000~6000. 

➢ Device name is to identify devices. 

➢ The emergency button can be enabled or disabled. Select the check box to enable 

emergency button, if it is enabled, the priority of manual emergency operation can be set. 

During the manually emergency broadcast on many devices, the device with high priority 

can cancel the manual emergency mode of the system. 

➢ The Emergency Button Task is used to automatically activate the manual emergency task 

when the manual emergency button is pressed. First, users need to add this task in task 

settings, then select it in the dropdown list. 

➢ The pre-signal and end-signal of microphone paging can be set separately, and the 

default setting is no signal. Only the audio files within 60s in audio library can be 

displayed in the drop down. 

➢ During the broadcast, device can detect microphone signal. If there is no sound for a 

period, the broadcast will be stopped automatically. Select the check box of voice 

detection can enable this function, and the period can be set meanwhile. 

➢ Line output is used to set the signal type, such as disable, monitor signal and output of 

microphone. The default setting is disabled. 

➢ Multicast channels mean the number of audio channels that can be played at the same 

time. It can’t be edited and only allows 20 channels at most, in which 5 channels are 

specified to play audio files of USB disk, recording broadcast, voice synthesis, line input 

signal and microphone paging. 

➢ First multicast IP allows to set the first multicast IP address for the network audio 

broadcast. Software automatically distribute the address and default is 224.0.6.*. The 

multicast IP addresses can neither be the same or conflicted with the address of X-

SMART. 

➢ Standby time means the time device automatically shut down the screen and get into 

standby status during which there is not any operation. There are 8 options like 10s, 20s 

and 30s, etc. can be selected. Default setting is never. 



 

 

➢ Picture is the picture shown in the standby window of X-NPMS. The maximum pixel is 

339*40. Click the button  to select the picture. 

➢ AOD Server IP is used to set the X-SMART server IP address when enable the AOD 

function. 

➢ Enable Buzzer and Enable System Fault Led are used to set warning and display the 

system fault status. 

➢ Show Date & Time is used to display current time. 

➢ Delete Temp. Rec. and Delete auto. Rec. are used to enable or disable this function 

button on the interface. 

• Extended Key Module Setting 

If extended key module X-K4 or X-K8 is used, the type of extend key modules can be chosen from 

here. Make sure it must be the same with the actual use. Default setting is none. 

• Network Setting 

Use to set the X-NPMS network parameter. Old IP is the IP address before setting, and New IP is 

the IP address after setting. For updating the network parameters of the system devices, it shall be 

connected to computer whose IP should be in the same segment with the old IP of X-NPMS.  

Click the Update button for setting the IP of X-NPMS, the two IP address would be the same after 

updating successfully. 

The default IP address is 192.168.2.100. If the specified IP address has been forgotten, the default 

IP address can be obtained from device window. 

Note: Network parameter is excluded in configuration files. Downloading configuration can’t 

change network configuration. It can be only changed by updating. While operating, please make 

sure device is connected to the network and the network settings are correct. 

• Storage 

Storage status is shown at the bottom of widow to help users understand the space that current 

audio files take up. The maximum available capability is 500MB. 

• REC FTP 

This function is unavailable now. 

 

2． Time  

 
"Time” is used to set the requisite parameter for the working clock, as shown below: 

• Time synchronization 

“Time synchronization” is the function to synchronize the time for X-NPMS through NTP 

protocol. Default setting is off. 

➢ If select NTP Server, X-NPMS will be set as a time server, the all other devices 

synchronize the time with it. In other words, the all other devices’ time would be in 

conformance with this X-NPMS’s. 

➢ If select NTP Client, X-NPMS automatically synchronize the time with time server. And 

need to set the Server IP address and Period. 

 



 

 

•  “Time Zone Setting” is used to set time zone of X-NPMS. Choose the time zone of current 

location, and click “Update” button to change the time zone of X-NPMS, if “All Devices” is 

selected, click “Update” will change the time zone of all devices. If the device time zone is 

different from the local time zone, the time and date displayed on device will be wrong. 

• “Date & Time Setting” is used to view and manually update the device’s date and time. Click 

“Get” button to read the device’s date & date. If only click “Update” button, the time and date of 

current X-NPMS will be changed. If select “All Devices” and click “Update” button, the time and 

date of all devices, such as X-DCS2000/EN, X-DCS3000, X-NPMS and X-NRI, will be 

changed. 

 Note: 

If firmware version of X-NPMS is V3.5.22 or above, users need to input device passport when read 

or edit Time Zone Setting. The default password is hon12345. 

 

3． Language 

Users can set the language displayed in X-NPMS interface as follows: 

 

Select the language in the dropdown list and click Update. 

Note 

The default languages are English and Simplified Chinese. If users want to set other languages, 

first please open the excel npms_language.xls in the folder translation from the installation 

directory, then insert a column beside the existed language and translate into your target language. 

Finally set the language from the dropdown list. 

If firmware version of X-NPMS is V3.5.22 or above, users need to input device passport when edit 

Language Setting. The default password is hon12345. 

 

4． Supervision 

The supervision of microphone and network communication can be set, which is shown as below: 

 

Select the corresponding check box for the supervision function. The icon  means enabled and 

 means disabled. 

 

 



 

 

5． Devices 

“Devices” is used to set the devices can be operated by X-NPMS. Select DCS for broadcast 

operation and X-NPMS for full duplex intercom, as shown below： 

 

• DCS List 

The DCS List displays all the DCS in the system. Check the check box to enable the 

corresponding DCS can be operated through X-NPMS. And then, another click the selected box to 

cancel it. 

• Devices for Intercom 

It displays all the NPMS in the system. Check the checkbox to select the corresponding X-NPMS 

which need to initiate this function. 

 

6． Groups 

Zone groups can be set for X-NPMS through configuration software. Each group can contain many 

zones. The Groups window is displayed as shown below： 

 

•  DCS List & Speaker Line List 

After finishing the DCS List setting in the step of Devices, all of the selected DCS would be 

displayed in the DCS List in this step. Select one DCS, and all zones connected to it would be 

displayed in the Speaker Line List. 

• Group List 

a. User has to create a group in the Group List. Click the  icon in the Group List view, the 

Add window is displayed as below: 



 

 

 

Enter the Group Name and select the category if it is necessary. The group will be 

displayed as the subdirectory under the category. Then click OK.  

b. Select one group and click  icon or double-click the list, the Edit window for editing the 

play list name as needed, is displayed as below: 

 

c. Select one or more groups in the Group List, and then click  icon to delete them.  

Right click in the list for Add Edit and Delete menu also can do the play list addition, edit 

or deletion operation. 

 

• Group Contents 

Select one group, the all the zones of that group would be displayed in the Zone Detail view. Left 

click and drag the zones into the Group Detail view. And the zones have been added. If left click 

and drag the DCS in the DCS List, all the zones belong to that DCS would be added into the Group 

Detail. 

If users want to delete some zones, only need to select the zones and click  icon to delete them. 

Task Settings 

Task mainly used to set the necessary tasks for the broadcast by the X-NPMS. Each task includes 

audio source, play policy, zone setting and dry contact to fulfill all the play operations. Task setting 

includes Play List and Task.  

1． Play List 

Play List is used to set the audio source and the play lists for the play tasks, as shown below: 



 

 

 

• Library 

X-NPMS, X-NPMI, NRI would share the audio library with X-DCS2000/EN, X-DCS3000 during 

configuration. The operation of adding and deleting library is the same as X-DCS3000. 

• Play List 

After finishing the library setting, the play list can be created, and classified into two types:  Public 

and Private, which are shown as below. Please refer to chapter X-DCS3000 for the operation of 

add, edit and delete. 

 

 

2． Task 

Task is used to view, add, modify or delete broadcast task, as shown below: 

 

• Task List 

The Play List displays all the task name, type, audio source, priority, delay, loop, resume, play full, 

busy wait and output dry contacts. 

• Add Task 

Click the icon  at the top right corner, the add task window will be displayed as below:   



 

 

 

Users need to enter task name, select audio type, set broadcast policy, select target and dry 

contact outputs. 

Task function and type can be clarified by the task name. 

There are normal and emergency type for the task, which means different priority. The less the 

value it is, the higher priority it has. 

➢ Normal task means the BGM, business broadcast and voice broadcast, etc., which 

ranges from 56~255. 

➢ Emergency task means the fire emergency broadcast, which ranges from 1~55. 

Audio type includes play list, net audio (e.g. line in of DCS or NRI), line in, microphone, external 

files and recorded files. The line in here means the line in port of the X-NPMS. 

➢ Play list can be used for voice broadcast, BGM, etc. Users can add audio files in the play 

list. 

➢ Net audio means the external and internal audio accessed by the NRI and X-DCS3000, 

which can be selected from the dropdown list. 

➢ Line in means the external audio source can be connected to access the X-NPMS. 

➢ Microphone of X-NPMS can be used for live announcement. 

➢ Users need to configure a task named as external files (USB) in X-NPMS if there is a 

need to broadcast audio from USB. 

➢ Users need to configure a task named as recorded file in X-NPMS if there is a need to 

broadcast recorded audio. 

➢ Users need to configure a task named as speech synthetic in X-NPMS if there is a need 

to broadcast speech synthetic. 

Policy is mainly used to set the importance for the task. 

➢ Delay: Edit this field to specify a time in the range of 0~600 second for which the audio is 

delayed before being played. 

➢ Priority is used to set the priority for broadcast. During the broadcast, the task with higher 

priority will be first broadcasted among many tasks. The smaller the value is, the higher 

the priority has. 

➢ Loop is only valid for play list. It shows the broadcast times and ranges from 1~65534. 

➢ Forever is used to set the broadcast non-stop. 



 

 

➢ Resume is used to stop playing the task and broadcast other task with higher priority 

when there are different tasks in one zone. After that, it will continually play the interrupted 

task. Check the checkbox to enable the function, if not, the interrupted task will not be 

recovered. 

➢ When the audio type is microphone, users can enable the record function to record during 

the broadcast by microphone. 

➢ Rep. interval is the interval time of repeats of the playlist, the range is from 0 to 3600s. 

The task will not be stopped within the interval time. 

➢ Song interval is the interval time between two audio files, the range is from 0 to 3600s. 

The task will not be stopped within the interval time. 

Target is used to select the desired zones for the task. Click the checkbox can select or click the 

icon  to select all, the icon  is to cancel all. 

The item of dry contact outputs is used to select the dry contact output which need to be activated 

by the task. Click the checkbox can select or click the icon  to select all, the icon  is to 

cancel all. If the checkbox of “Match speaker lines” is enabled, the dry contact outputs will be 

activated with following speaker lines. For example, dry contact output 1 will be activated when 

zone 1 is broadcasting. This function can be used to control the volume controllers on each 

speaker lines. Here the dry contact output means the zone related output during the broadcast, it 

cannot control the contact outputs of other device without broadcasting. 

There is an “Extend” at the left bottom, which can set some additional attributes used for the third 

system integration.  

Users can click “Description” and add some description for the task, which will be displayed in X-

NPMS. 

After setting, click “OK” to save. 

• Edit Task 

Select a task, then click the icon  at the top right corner or double left click the task, the edit 

window will be displayed. 

• Delete Task 

Select a task, then click the icon  at the top right corner, a prompt window will be display to 

confirm deleting. 

In the task list, users can also add, copy, paste, edit or delete the task by right click. 

Operation Settings 

Operation settings are used to set following contents: 

➢ Key function, trigger mode and content. 

➢ Set the name, function, and trigger mode and content of one-click button of X-NPMS. 

➢ Set manually broadcast function. 

➢ Category, voice segments of speech synthesis. 

➢ Users and permission. 

 

1． Physical Keys 

All equipped extend key modules, such as X-K4 or X-K8 will be displayed in key list. Users can 

double click the item or click  at the option to set function and trigger mode.  



 

 

 

Task broadcast, volume control, speaker line, group and close zones can be specified to a key. 

The default function is none. Two trigger modes can be chosen for task broadcast, such as press 

and toggle. Only toggle option can be selected for other functions.  

• Task Broadcast 

Toggle or press can be selected in task broadcast function. Toggle means click once to start task 

and one more click to stop. Press means task is started after pressing, and button should be kept 

pressing during broadcast. Once release, broadcast is stopped. Choose corresponding task in task 

name. 

 

• Volume Control 

If volume control is selected for the function, users can set volume step and target zone or group. 

Press the button can increase or reduce the volume. 

 

• Speaker Line 

It is used to select target zone to conduct full broadcast. Users need to set zones if speaker line is 

selected for function. Enable the front check box to set zones.  



 

 

 

• Group 

Click the front check box to select groups, which is shown as below. 

 

• Close Zones 

It is used to close the selected zones. Keys can be set to close zones by settings.  

 

 

 

 

 



 

 

2． One-Click Buttons 

One-Click buttons correspond the One-Click operation in X-NPMS. Users double click the options 

in window or click   can set name, function of relevant options. 

 

If users select task broadcast as button name. Click trigger mode to choose toggle or press, and 

choose specific task by clicking task name. 

 

 

3． Manually Broadcast 

The zones and tasks can be set to be controlled by manually broadcast. 

  

In above two lists, one list shows the zones and groups can be controlled by X-NPMS, another 

shows the task list can be used in manually broadcast window. Choose zones in left upper window, 

and left click to drag them to left bottom list. Each zone and group is corresponding to the buttons 

in manually broadcast. Click  or  button to adjust their positions. Then choose some or all 

tasks in the right upper list, keep left clicking and drag them to Selected Tasks. 

 

4． Speech Synthesis 

Broadcast operation of speech synthesis can be conducted by X-NPMS. Relevant settings, such 

as task setting and content setting should be configured before operation. Please refer to the 

chapter task setting of X-NPMS for setting speech synthesis task. Content settings of speech 

synthesis are languages, audio files and synthesis.  

 

 



 

 

• Languages 

Use to set broadcast language, which is shown as follows: 

 

Select the check box to enable the language. Click  can add new languages and input names. 

Choose a language and click  can delete it. The order of the language in list is also the 

broadcast order in X-NPMS. Click   and  to adjust the order. In the same system, every X-

NPMS can have different languages, but broadcast order is the same. 

• Audio Files 

Users can set the basic elements for speech synthesis, which are speech segments. Speech 

segments, including description and audio files can be added here. 

 

Voice description means the word contents, which can be input directly and will be displayed in the 

operation menu of X-NPMS. Click  to select audio files, and click  to delete. Every speech 

segment should include some corresponding audio files, otherwise broadcast may occur error. 

• Synthesis 

Synthesis rules, category and its corresponding speech included can be set in this window. 

 

Category list shows the all speech types. Click  to add new categories and click  to delete. 

Name of category can be input directly. Select the front check box to enable the category in the X-

NPMS. 

After selecting a category, the voice segments can be set. Each category can include 10 segments 

at most, and each segment can have up to 255 optional audio files. Users can pick audio files to 

synthesize a completed sentence. Audio files list displays all the configured files. Users can first 

choose a category, and select segment number, then click required files and drag to voice 

segments list.  

Note that the segments should be continued and started from 1, otherwise software will display 

error message when downloading configuration. 

Choose one audio file and click  to delete. 

 



 

 

Note:  

When there are many X-NPMS devices in system, the relative contents of “Speech Synthesis” 

such as “Languages”, “Audio Files” and “Speech Category” can be shared at all X-NPMS devices. 

Users can choose language type and speech category as required. Different languages will be 

broadcasted according to the sequence in language list when there are multiple languages 

enabled in speech synthesis.  

 

5． Volume Zones 

Volume zones is used to set the zones or groups which volume can be adjusted by X-NPMS. 

 

Available Groups or Speaker Lines displays the groups or zones, of which volume can be adjusted. 

Users choose one or more zones, then left click and drag it into below list. Click the icon  and 

 can adjust the displaying order. Please note that zone volume and group volume will be 

displayed in two interfaces in X-NPMS. 

 

6． User Setting 

Users can set user name, password and operation permissions. 

  

 

 

 



 

 

• User List 

Click  to add a new user, input name and password. Select one user, click  to edit its 

name and password, click  to delete it. 

 

 

• Operator Permissions 

After selecting one user, functions are listed. Functions without permissions won’t be displayed. 

Choose the check box to enable the permission. Click  to select all, and  to cancel all.  

Note: 

If there is only one user configured in X-NPMS whose password is empty, the login screen won’t 

be shown and user can directly enter the main interface. User’s permission can be still set through 

configuration software. 

X-NPMIC Setting 

Select an X-NPMIC in the Project explorer view, the three navigation buttons in the top left of the 

view will refer users to configure the following settings: 

• Device 

- Properties 

- Time 

- Supervision 

- Devices 

- Groups  

• Task 

- Play List 

- Task 

• Operation 

       - Physical Keys 

Device Settings 

The basic function parameters for the X-NPMIC can be set under this tab. These items such as 

Properties, Time, Supervision, Devices and Groups will be set in turn. 

1． Properties 

 “Properties” is used to set the requisite parameters for the X-NPMIC working normally, as shown 

below：  



 

 

 

• Basic Setting 

Basic Setting includes ID, Name, Emergency button priority, Trigger Type and etc. 

➢ Device ID is the only device identification in the system, which in the range of 5000~6000. 

➢ Enter a name to mark the device for the convenience of user’s identification. 

➢ Pre-signal and end-signal can be set separately, the default is none. Only the audio files 

within 60s can be displayed in the drop list. 

➢ During the broadcasting, device can detect microphone signal. When there is no voice for 

a while, the broadcast will be automatically finished. Check the box of Voice Detection 

can enable this function and set the detection time. 

➢ Line output is to set the type of the output signal, options are disabled, monitor signal and 

microphone. The default is disabled. 

➢ Multicast channels means the audio channels which can be broadcasted at the same time. 

Up to 20 channels can be broadcasted, from which 5 multicast channels are used to 

broadcast audio files from USB, recorded files, synthesis voice, line input and microphone, 

etc. 

➢ First multicast IP is used to set the first multicast IP for Internet audio broadcast, the 

default is 224.0.6.*. Note the voice multicast IP of each X-NPMIC should be different, and 

avoid conflicted with the one of X-SMART. 

➢ Standby time means the time device automatically shut down the screen and get into 

standby status during which there is not any operation. There are 8 options like 10s, 20s 

and 30s, etc. can be selected. Default setting is never. 

➢ Picture is the picture shown in the standby window of X-NPMS. The maximum pixel is 

339*40. Click the button  to select the picture. 

➢ AOD Server IP is used to set the X-SMART server IP address when enable the AOD 

function. 

➢ Enable Buzzer and Enable General Fault are used to set warning and display the system 

fault status. 

➢ Show Date & Time is used to display current time. 



 

 

➢ Delete temp. Rec. files and Delete auto. Rec. files are used to enable or disable this 

function button on the interface. 

• Network Setting 

Use to set the X-NPMIC network parameter. Old IP is the IP address before setting, and New IP is 

the IP address after setting. For updating the network parameters of the system devices, it shall be 

connected to computer whose IP should be in the same segment with the old IP of X-NPMIC.  

After click Update, the IP will update successfully, and the two IP address would be the same. 

The default IP address is 192.168.2.100. The current IP address can be checked and updated by 

screen. 

• Storage 

Storage is used to check the current status of storage space. The maximum space is 500MB. 

 

2． Time 

 "Time” is used to set the requisite parameter for the working clock, as shown below: 

 

• Synchronization Mode 

       “Synchronization Mode” is the function to synchronize the time for X-NPMIC through NTP 

protocol. Default setting is off. 

➢ If select NTP Server, X-NPMIC will be set as a time server, the all other devices 

synchronize the time with it. In other words, the all other devices’ time would be in 

conformance with this X-NPMIC’s. 

➢ If select NTP Client, X-NPMIC automatically synchronize the time with time server. And 

need to set the Server IP address and Period. 

• “Time Zone Setting” is used to view and manually update the device’s date and time. Click 

“Get” button to read the device’s date & date. If only click “Update” button, the time and date of 

current X-NPMIC will be changed. If select “All Devices” and click “Update” button, the time 

and date of all devices, such as X-DCS2000/EN, X-DCS3000, X-NPMS, X-NPMIC and X-NRI, 

will be changed. 

 

3． Supervision 

The supervision of microphone and network communication can be set, which is shown as below: 

 

Select the corresponding check box for the supervision function. The icon  means enabled and 

 means disabled. 

 



 

 

4． Devices 

“Devices” is used to select the DCS for operation and the X-NPMIC for full duplex intercom, as 

shown below: 

 

• DCS List 

The DCS List displays all the DCS in the system. Check the check box to enable the 

corresponding DCS can be operated through X-NPMIC. And then, another click the selected 

box to cancel it. 

• Devices for Intercom 

The X-NPMIC List displays all the X-NPMIC in the system. Check the check box to select the 

corresponding X-NPMIC which is wanted to initiate the full duplex intercom function with them. 

And then, another click the selected box to cancel it. 

 

5． Groups 

For user's convenience, there are some groups can be set for the X-NPMIC through config 

software. Each group can contain many zones. The Groups window is displayed as shown 

below： 

 

• DCS List & Speaker Line List 

After finishing the DCS List setting in the step of Devices, all of the selected DCS would be 

displayed in the DCS List in this step. Select one DCS, and all zones connected to it would be 

displayed in the Zone List. 

 

 

 

 

 

 



 

 

• Group List 

First of all, the user has to create a group in the Group List. Click the  icon in the Group List 

view, the Add window is displayed as below: 

 

Enter the Group Name, and click OK to create a new group. 

Select one group and click  icon or double-click the list, the Edit window for editing the play list 

name as needed, is displayed as below: 

 

Select one or more groups in the Group List, and then click  icon to delete them. 

Right click in the group list can also add, edit and delete the groups through the menu. 

 

• Group Contents 

Select one group, the all the zones of that group would be displayed in the Zone Detail view. Left 

click and drag the zones into the Group Detail view. And the zones have been added. If left click 

and drag the DCS in the DCS List, all the zones belong to that DCS would be added into the Group 

Detail. 

If users want to delete some zones, only need to select the zones and click  icon to delete them. 

Task Settings 

Task mainly used to set the necessary tasks for the broadcast by the X-NPMIC. Each task includes 

audio source, play policy, zone setting and dry contact to fulfill all the play operations. 

Task setting includes Play List and Task.  

1. Play List 

Play List is used to set the audio source and the play lists for the play tasks, as shown below: 

 



 

 

• Library 

During the configuration, X-NPMI, X-NPMS, X-NPMIC and NRI share audio source with X-

DCS2000/EN and X-DCS3000. The operations to add and delete are the same as operation on X-

DCS2000/EN. 

• Play List  

After finishing the library setting, the play list can be created. In X-NPMIC, there is only public play 

list can be used, which shown as below. The operations to add, edit and delete are the same as 

operation on X-DCS2000/EN. 

 

 

2. Task 

“Task” is used to review, add, edit and delete the broadcast task, which shown as below. For 

operation, please refer to X-DCS2000/EN. 

 

• Task List 

The Play List displays all the task name, type, audio source, priority, delay, loop, resume, play full, 

busy wait and output dry contacts. 

• Add 

Click the icon  at the top right corner, the add task window will be displayed as below: 

 



 

 

Users need to enter task name, select audio type, set broadcast policy, select target and dry 

contact outputs. 

Task function and type can be clarified by the task name. 

There are normal and emergency type for the task, which means different priority. The less the 

value it is, the higher priority it has. 

➢ Normal task means the BGM, business broadcast and voice broadcast, etc., which 

ranges from 56~255. 

➢ Emergency task means the fire emergency broadcast, which ranges from 1~55. 

Audio type includes play list, net audio (e.g. line in of DCS or NRI), line in, microphone, external 

files and recorded files. The line in here means the line in port of the X-NPMS. 

➢ Play list can be used for voice broadcast, BGM, etc. Users can add audio files in the play 

list. 

➢ Net audio means the external and internal audio accessed by the NRI and X-DCS3000, 

which can be selected from the dropdown list. 

➢ Line in means the external audio source can be connected to access the X-NPMIC. 

➢ Microphone of X-NPMIC can be used for live announcement. 

Policy is mainly used to set the importance for the task. 

➢ Delay: Edit this field to specify a time in the range of 0~600 second for which the audio is 

delayed before being played. 

➢ Priority is used to set the priority for broadcast. During the broadcast, the task with higher 

priority will be first broadcasted among many tasks. The smaller the value is, the higher 

the priority has. 

➢ Loop is only valid for play list. It shows the broadcast times and ranges from 1~65534. 

➢ Forever is used to set the broadcast non-stop. 

➢ Rep. interval is the interval time of repeats of the playlist, the range is from 0 to 3600s. 

The task will not be stopped within the interval time. 

➢ Resume is used to stop playing the task and broadcast other task with higher priority 

when there are different tasks in one zone. After that, it will continually play the interrupted 

task. Check the checkbox to enable the function, if not, the interrupted task will not be 

recovered. 

➢ When the audio type is microphone, users can enable the record function to record during 

the broadcast by microphone. 

➢ Song interval is the interval time between two audio files, the range is from 0 to 3600s. 

The task will not be stopped within the interval time. 

Target is used to select the desired zones for the task. Click the checkbox can select or click the 

icon  to select all, the icon  is to cancel all. 

The item of dry contact outputs is used to select the dry contact output which need to be activated 

by the task. Click the checkbox can select or click the icon  to select all, the icon  is to 

cancel all. If the checkbox of “Match speaker lines” is enabled, the dry contact outputs will be 

activated with following speaker lines. For example, dry contact output 1 will be activated when 

zone 1 is broadcasting. This function can be used to control the volume controllers on each 

speaker lines. Here the dry contact output means the zone related output during the broadcast, it 

cannot control the contact outputs of other device without broadcasting. 

After setting, click “OK” to save. 

• Edit Task 

Select a task, then click the icon  at the top right corner or double left click the task, the edit 

window will be displayed. 

• Delete Task 

Select a task, then click the icon  at the top right corner, a prompt window will be display to 

confirm deleting. 



 

 

Operation Settings 

Operation setting is used to set the button function of X-NPMIC. 

Physical keys display the available keys. Users double click the key or click the  after selecting 

the key, the function and trigger mode can be set. 

Only the broadcast task can be set to realize the one click function. 

 

Select the broadcast task as the function and set the trigger mode, then select the relative task. 

X-NPMK Setting 

Select an X-NPMK in the Project explorer view, the three navigation buttons in the top left of the 

view will refer users to configure the following settings: 

• Device 

- Properties 

- Time 

- Supervision 

- Devices 

- Groups  

• Task 

- Play List 

- Task 

• Operation 

       - Physical Keys 

Device Settings 

The basic function parameters for the X-NPMK can be set under this tab. These items such as 

Properties, Time, Supervision, Devices and Groups will be set in turn. 

1． Properties 

 “Properties” is used to set the requisite parameters for the X-NPMK working normally, as shown 

below：  



 

 

 

• Basic Setting 

Basic Setting includes ID, Name, Emergency button priority, Trigger Type and etc. 

➢ Device ID is the only device identification in the system, which in the range of 5000~6000. 

➢ Enter a name to mark the device for the convenience of user’s identification. 

➢ Pre-signal and end-signal can be set separately, the default is none. Only the audio files 

within 60s can be displayed in the drop list. 

➢ During the broadcasting, device can detect microphone signal. When there is no voice for 

a while, the broadcast will be automatically finished. Check the box of Voice Detection 

can enable this function and set the detection time. 

➢ Line output is to set the type of the output signal, options are disabled, monitor signal and 

microphone. The default is disabled. 

➢ Multicast channels means the audio channels which can be broadcasted at the same time. 

Up to 20 channels can be broadcasted, from which 5 multicast channels are used to 

broadcast audio files from USB, recorded files, synthesis voice, line input and microphone, 

etc. 

➢ First multicast IP is used to set the first multicast IP for Internet audio broadcast, the 

default is 224.0.6.*. Note the voice multicast IP of each X-NPMK should be different, and 

avoid conflicted with the one of X-SMART. 

➢ Standby time means the time device automatically shut down the screen and get into 

standby status during which there is not any operation. There are 8 options like 10s, 20s 

and 30s, etc. can be selected. Default setting is never. 

➢ Picture is the picture shown in the standby window of X-NPMS. The maximum pixel is 

339*40. Click the button   to select the picture. 

➢ AOD Server IP is used to set the X-SMART server IP address when enable the AOD 

function. 

➢ Enable Buzzer and Enable General Fault are used to set warning and display the system 

fault status. 

➢ Show Date & Time is used to display current time. 

➢ Delete temp. Rec. files and Delete auto. Rec. files are used to enable or disable this 

function button on the interface. 



 

 

• Network Setting 

Use to set the X-NPMK network parameter. Old IP is the IP address before setting, and New IP is 

the IP address after setting. For updating the network parameters of the system devices, it shall be 

connected to computer whose IP should be in the same segment with the old IP of X-NPMK.  

After click Update, the IP will update successfully, and the two IP address would be the same. 

The default IP address is 192.168.2.100. The current IP address can be checked and updated by 

screen. 

• Storage 

Storage is used to check the current status of storage space. The maximum space is 500MB. 

 

2． Time 

 "Time” is used to set the requisite parameter for the working clock, as shown below: 

 

• Synchronization Mode 

       “Synchronization Mode” is the function to synchronize the time for X-NPMK through NTP 

protocol. Default setting is off. 

➢ If select NTP Server, X-NPMK will be set as a time server, the all other devices 

synchronize the time with it. In other words, the all other devices’ time would be in 

conformance with this X-NPMK’s. 

➢ If select NTP Client, X-NPMK automatically synchronize the time with time server. And 

need to set the Server IP address and Period. 

• “Time Zone Setting” is used to view and manually update the device’s date and time. Click 

“Get” button to read the device’s date & date. If only click “Update” button, the time and date of 

current X-NPMK will be changed. If select “All Devices” and click “Update” button, the time and 

date of all devices, such as X-DCS2000/EN, X-DCS3000, X-NPMS, X-NPMIC and X-NRI, will 

be changed. 

 

3． Supervision 

The supervision of microphone and network communication can be set, which is shown as below: 

 

Select the corresponding check box for the supervision function. The icon  means enabled and 

 means disabled. 

 

 

 



 

 

4． Devices 

“Devices” is used to select the DCS for operation and the X-NPMK for full duplex intercom, as 

shown below: 

 

• DCS List 

The DCS List displays all the DCS in the system. Check the check box to enable the 

corresponding DCS can be operated through X-NPMK. And then, another click the selected 

box to cancel it. 

• Devices for Intercom 

The X-NPMK List displays all the X-NPMK in the system. Check the check box to select the 

corresponding X-NPMK which is wanted to initiate the full duplex intercom function with them. 

And then, another click the selected box to cancel it. 

 

5． Groups 

For user's convenience, there are some groups can be set for the X-NPMK through config software. 

Each group can contain many zones. The Groups window is displayed as shown below： 

 

• DCS List & Speaker Line List 

After finishing the DCS List setting in the step of Devices, all of the selected DCS would be 

displayed in the DCS List in this step. Select one DCS, and all zones connected to it would be 

displayed in the Zone List. 

• Group List 

First of all, the user has to create a group in the Group List. Click the  icon in the Group List 

view, the Add window is displayed as below: 



 

 

 

Enter the Group Name, and click OK to create a new group. 

Select one group and click  icon or double-click the list, the Edit window for editing the play list 

name as needed, is displayed as below: 

 

Select one or more groups in the Group List, and then click  icon to delete them. 

Right click in the group list can also add, edit and delete the groups through the menu. 

 

• Group Contents 

Select one group, the all the zones of that group would be displayed in the Zone Detail view. Left 

click and drag the zones into the Group Detail view. And the zones have been added. If left click 

and drag the DCS in the DCS List, all the zones belong to that DCS would be added into the Group 

Detail. 

If users want to delete some zones, only need to select the zones and click  icon to delete them. 

Task Settings 

Task mainly used to set the necessary tasks for the broadcast by the X-NPMK. Each task includes 

audio source, play policy, zone setting and dry contact to fulfill all the play operations. 

Task setting includes Play List and Task.  

1. Play List 

Play List is used to set the audio source and the play lists for the play tasks, as shown below: 

 

 

 

 



 

 

• Library 

During the configuration, X-NPMK, X-NPMI, X-NPMS, X-NPMIC and NRI share audio source with 

X-DCS2000/EN and X-DCS3000. The operations to add and delete are the same as operation on 

X-DCS2000/EN. 

• Play List  

After finishing the library setting, the play list can be created. In X-NPMK, there is only public play 

list can be used, which shown as below. The operations to add, edit and delete are the same as 

operation on X-DCS2000/EN. 

 

 

2. Task 

“Task” is used to review, add, edit and delete the broadcast task, which shown as below. For 

operation, please refer to X-DCS2000/EN. 

 

• Task List 

The Play List displays all the task name, type, audio source, priority, delay, loop, resume, play full, 

busy wait and output dry contacts. 

• Add 

Click the icon  at the top right corner, the add task window will be displayed as below: 



 

 

 

Users need to enter task name, select audio type, set broadcast policy, select target and dry 

contact outputs. 

Task function and type can be clarified by the task name. 

There are normal and emergency type for the task, which means different priority. The less the 

value it is, the higher priority it has. 

➢ Normal task means the BGM, business broadcast and voice broadcast, etc., which 

ranges from 56~255. 

➢ Emergency task means the fire emergency broadcast, which ranges from 1~55. 

Audio type includes play list, net audio (e.g. line in of DCS or NRI), line in, microphone, external 

files and recorded files. The line in here means the line in port of the X-NPMK. 

➢ Play list can be used for voice broadcast, BGM, etc. Users can add audio files in the play 

list. 

➢ Net audio means the external and internal audio accessed by the NRI and X-DCS3000, 

which can be selected from the dropdown list. 

➢ Line in means the external audio source can be connected to access the X-NPMK. 

➢ Microphone of X-NPMK can be used for live announcement. 

Policy is mainly used to set the importance for the task. 

➢ Delay: Edit this field to specify a time in the range of 0~600 second for which the audio is 

delayed before being played. 

➢ Priority is used to set the priority for broadcast. During the broadcast, the task with higher 

priority will be first broadcasted among many tasks. The smaller the value is, the higher 

the priority has. 

➢ Loop is only valid for play list. It shows the broadcast times and ranges from 1~65534. 

➢ Forever is used to set the broadcast non-stop. 

➢ Rep. interval is the interval time of repeats of the playlist, the range is from 0 to 3600s. 

The task will not be stopped within the interval time. 



 

 

➢ Resume is used to stop playing the task and broadcast other task with higher priority 

when there are different tasks in one zone. After that, it will continually play the interrupted 

task. Check the checkbox to enable the function, if not, the interrupted task will not be 

recovered. 

➢ When the audio type is microphone, users can enable the record function to record during 

the broadcast by microphone. 

➢ Song interval is the interval time between two audio files, the range is from 0 to 3600s. 

The task will not be stopped within the interval time. 

Target is used to select the desired zones for the task. Click the checkbox can select or click the 

icon  to select all, the icon  is to cancel all. 

The item of dry contact outputs is used to select the dry contact output which need to be activated 

by the task. Click the checkbox can select or click the icon  to select all, the icon  is to 

cancel all. If the checkbox of “Match speaker lines” is enabled, the dry contact outputs will be 

activated with following speaker lines. For example, dry contact output 1 will be activated when 

zone 1 is broadcasting. This function can be used to control the volume controllers on each 

speaker lines. Here the dry contact output means the zone related output during the broadcast, it 

cannot control the contact outputs of other device without broadcasting. 

After setting, click “OK” to save. 

• Edit Task 

Select a task, then click the icon  at the top right corner or double left click the task, the edit 

window will be displayed. 

• Delete Task 

Select a task, then click the icon  at the top right corner, a prompt window will be display to 

confirm deleting. 

Operation Settings 

Operation setting is used to set the button function of X-NPMK. 

Physical keys display the available keys. Users double click the key or click the  after selecting 

the key, the function and trigger mode can be set. 

Only the broadcast task can be set to realize the one click function. 

 

Select the broadcast task as the function and set the trigger mode, then select the relative task. 

 

 

 

 

 

 

 

 



 

 

X-NRI Setting 

Select the NRI in the Project explorer view, the three available navigation buttons in the top left of 

the view can refer users to configure the following settings: 

• Device 

- Properties 

- Supervision 

- Linkage 

• Task 

- Play List 

- Task 

- Groups 

Device Settings 

The basic function parameters for the NRI can be set under this tab. These items such as 

Properties and Supervision will be set in turn. 

1． Properties 

“Properties” is used to set the requisite parameters for the NRI working normally, includes Base 

Setting, Network Setting, Date & Time, Fire Alarm Interface List and Audio Source Setting, as 

shown below: 

 

• Basic Setting 

Base Setting includes Device ID, Device Name and Storage. Device ID is the only device 

identification in the system, which in the range of 7000~8000. Enter a name to mark the device for 

the convenience of user’s identification. Storage used to select the audio files’ storage position. 

Built-in 500MB flash (Max. 96 minutes) and 4GB SD card are selectable. Master is used to set the 

current NRI as a master one or not. If the NRI is set to be a master one, the fault status of all the 

equipment in the same device group will be sent to this mater NRI. When the system has any fault, 

the NRI will send out acousto-optic warning and the dry contact fault signal: short circuit signal 

when in normal; open circuit signal when some fault occurs.  

Only one NRI can be set as master in each device group. 



 

 

• Network Setting 

Use to set the NRI network parameters. Old IP is the IP address before setting, and New IP is the 

IP address after setting. For updating the network parameters of the system devices, it shall be 

connected to computer whose IP should be in the same segment with the old IP of NRI. Click the 

Update button for setting the IP of NRI, the two IP address would be the same after updating 

successfully. The default IP address is 192.168.2.200. If the upload of settings to the devices failed, 

or if the specified IP address has been forgotten, the default IP address can be obtained by 

pressing the appropriate button to reset the IP address. 

Note: Network parameter is excluded in configuration files. Downloading configuration can’t fix 

network configuration, which can be only fixed by updating. While operating, please make sure 

device is connected to the network and the network settings are correct. 

• Date& Time Setting 

 “Date& Time” used to view and manually update the device’s date and time. Click on Get icon to 

get the device’s date& time. Only click on Update icon enabled to conform this NRI’s date& time to 

PC, otherwise either not only click on Update icon but also check the check box to conform all 

devices’ date & time, which included all DCS and NRI, to PC at the same time. 

• Used Space 

Storage status bar is shown at the bottom, which help users to know the space that current files 

take up. The maximum space is 500MB. 

• Fire Alarm Interface 

This item is used to set the NRI’s fire alarm interface mode: Disabled, Contact inputs or LPI-

ModBus. The default setting is disabled. If select contact inputs, it supports up to 32 trigger signal 

inputs. If select LPI-ModBus, it supports up to 256 zones of 32 DCS. After select fire alarm 

interface, linked devices are also need to be chosen. 

 

Click check box to select DCS. Then click OK to switch to fire alarm interface, we can see the all 

selected zones are displayed.  

When select interface LPI-ModBus, users need to set the quantity of control register and status 

register. Operations are as follows: 

 



 

 

Because NRI supports up to 32 DCS fire alarm linkage, there are 32 status registers and 32 control 

registers in the NRI. Each DCS corresponds to 1 status register and 1 control register. And the 

numbers of each module corresponding the control register and status register have to be set. The 

total control register numbers cannot be more than 32, so do the status register. Besides, the 

corresponding setting of LPI-ModBus has to be done. The setting method, please refer to LPI-

ModBus converter User’s Manual. 

  Note: 

If the fire alarm interface of NRI is enabled, the fire alarm interface of DCS has to select Network-

NRI. 

• Audio Source Setting 

Audio Source Setting mainly used to set the parameters for 5 audio sources which send from NRI 

to the Network. The setting contents include: enable/disable, source name, multi-case IP and audio 

source. There are 5 audio sources through an Ethernet network, 4 inputs that can connect to 

external audio sources, and 1 built-in audio source. And the external audio source interfaces have 

2 types: auxiliary input and balance input. 

Check the check box or not to enable/ disable the audio source as needed. 

Set the source name, so the correct audio source can be selected when the play task is set. 

Click the cell of Audio Source, and select the audio source from the drop - down menu as needed, 

including Auxiliary Input, Balance Input and the play list of the NRI. 

 Only make sure the actual interfaces for the external audio sources are consistent with 

configuration can NRI works normally. 

Note: 

When NRI audio source is enabled, device will broadcast input audio source to network 

continuously, except the audio source of emergency broadcast. To avoid network jam, It is 

recommended not to enable the audio sources which haven’t been used before. 

• Device Status Output 

The general fault status of system can be outputted to third party system through dry contact 

outputs of NRI, select a dry contact output port, and set it to be general fault output in function list. 

 

 

 

 

 

 

 

 

 

 

 



 

 

2． Supervision 

“Supervision” is used to enable or disable supervision functions, and the parameter for check as 

shown below: 

 

Through the software, users can respectively enable or disable fault supervisions for the AC power, 

DC power, Communication. The icon  means enable and  means disable. 

3． Linkage 

Linkage is used to set the fire alarm linkage function for NRI. Enable to set the zones are linked by 

each contact input, as shown below: 

 

One column corresponds to one contact input, according to the fire alarm interface setting 

foregoing, the contact inputs can be the dry contact input signal, or the fire signal send from the fire 

alarm system through LPI-ModBus. 

 One page can display up to 32 contact inputs, users can select the other pages through clicking 

the drop - down list. One low corresponds to one zone; drag the scroll bar to view more contents. 

For example, as shown above, the contact inputs 1~8 respectively relate with zone1~zone8 of 

DCS2, and give an alarm in the ±1 adjacent zones. 

 

There are some setting tools in the upper right: 

Evacuation: Used to set the evacuation zones, which are related by the contact inputs. 

 Alert: Used to set the alert zones, which are related by the contact input. 



 

 

Clear: Used to cancel the setting of some cell. 

Clear current DCS flags: Used to cancel all the zones’ setting of the DCS whose region is focus 

on by the cursor.  

Clear all flags: Used to cancel all the cells’ setting in the view. 

Select: Used to select cells. 

Click  icon or  icon, and then click the zones’ cells to set to be related by the contact input. 

Use the clear tools can cancel the setting. 

  Note: 

When communicate with fire alarm system through, the devices in the same group can linkage with 

each other. 

Fire alarm relation setting should be consistent with task setting. If only the evacuation task is set 

in a fire, only the evacuation zones need to be set in the fire alarm relation view, the alert setting is 

invalid. 

If DCS works in B mode and automatic emergency broadcast can be evacuation audio and alert 

audio, it is recommended that each contact input linkage 2 zones which correspond to the same 

power amplifier channel at the same time, if the 2 zones respectively broadcast evacuation audio 

and alert audio, the evacuation audio first. 

Task Settings 

 Task setting mainly used to set the NRI inner play list.  

1． Play List 

Use to set audio resource, including library and play list. 

 

• Library  

NPM and NRI share library with DCS, the way to add and delete is the same as operation on DCS. 

• Play List 

The ways and means for setting are almost as the same as DCS’s, except that: The play list type 

has to be Private immovably. 

 

2． Task 

The task types include: Evacuation, Alert and Telephone, as shown below: 



 

 

Click  icon, the Add window is displayed as below: 

 

The ways and means for setting are analogous to DCS, except the following contents: 

The task types include: Evacuation, Alert and Telephone, for Evacuation task and Alert task, the 

play list (DCS inner audio source) and the Net audio (NRI audio source) can be selected; for 

Telephone task, only the external audio source of the NRI can be selected. 

If users have selected LPI-ModBus as the NRI fire alarm interface, and set the evacuation task or 

the alert task, the software will automatically distribute these tasks to the virtual contact input of the 

DCS that has been related in the Fire Alarm Relation. The setting status will be viewed in the 

virtual contact input window in the Operation tab. 

When users set the telephone task, they need to set up to 128 phone groups. Click Group Setting 

button in the lower left of the telephone task add window, the Phone Group Setting window is 

displayed as shown below: 

 



 

 

Select one phone group in the Phone Group Setting list, the Zone List, lies vertically below the 

group list, will display all the zones of that group. Select one DCS in the DCS List, the all zones of 

that DCS will be displayed in the corresponding Zone List. Left click and drag the one or more 

zones into the zone list of the phone group, the zones would be added. If left click and drag the 

DCS in the DCS List, all the zones belong to that DCS would be added into the phone group. 

If users want to delete some zones of the phone group, only need to select the zones and click  

icon to delete them. 

Click  to select all zones, and click  to cancel all. 

Download Setting 

Please confirm all the configuration items had be set already before download setting, but also 

confirm the PC had been connected with the X-618 system through an Ethernet network. And the 

IP address of PC and devices has to be set in the same segment. 

And then click Download button, the software will check the configuration contents automatically. If 

any errors existed, the Error window would display all the error items, as shown below: 

 

According to the error tips, please correct the all error contents one by one. Unless there are no 

errors that need correction, clicking the Download button would lead to the Download window 

directly, as shown below: 

 

 

 



 

 

Note： 

Users need to input device password when download setting, the default password is hon12345. 

 

If a large amount of devices had be set in the project, in order to choose the needed devices and 

contents to download conveniently, DCS, NPMI, NPMS and NRI are respectively distributed to 4 

unattached tab. 

As needed, there are 4 select methods as following: 

• Check the All DCS, All NPMI, All NPMS, All NRI check box on the top of the upload window, 

the all contents of the corresponding device types would be selected. 

• Select the contents such as configure file, audio file or timing data one by one. 

• Check the All check box to select all the uploaded contents of the corresponding device at the 

same time. 

When there are many device groups, click the device group button in the left bottom to select 

groups that need download configuration. 

 

Select the front check box to choose or you can click the icon  for choosing all devices, and the 

icon  for cancel all. Click OK to save the settings and close the window. 

Finish contents selecting, and then click Download button to download data through an Ethernet 

network. If any DCS’s configuration file has been selected and download, the whole project’s 

configuration file (not include audio file) will be downloaded the corresponding DCS automatically, 

in other word, the project’s configuration file will be backup in all the DCS those have finished 

downloading configuration files.  The device corresponding progress bar and text tip remind the 

current state of upload. 

  Note: 

If the data cannot be uploaded normally, the user can deal with the errors as following: 

Check the connection between PC and device. 

Check the IP address setting of PC and devices. 

Check the firewall setting to avoid the software from bloc 

 



 

 

5    Additional Function 
This section describes special functions and operations of the X-618 Config software, such as 

Browse Record Files, Upgrade Firmware, Export Device List, Download Project File and Select 

Language. This software also provides the function that the software language can be customized 

freely as area needed. Next, we will describe the detail of the function as follow: 

Browse Record Files in DCS 

Click the software menu: “Tools” --- > “Brower Record Files in DCS”, the window is displayed as 

shown below: 

 

Select DCS device in drop down, here only X-DCS2000 can be displayed. Click query button, then 

all record files of the device are shown. Click the icon  to audition the record. Select record files 

and then click export button to download the record files to local. 

Browse Record Files in X-NPMS 

Click the software menu: “Tools” --- > Brower Recorded Files in X-NPMS”, the window is displayed 

as shown below: 

 

Select X-NPMS device in drop down, and click query button, then all record files in the device are 

shown. Click the icon  to play the record. Select record files and then click export button to 

save the record files to local. 



 

 

 Note: 

If firmware version of X-NPMS is V3.5.22 or above, users need to input device passport when 

query. The default password is hon12345. 

 

Export Device List 

This software provides device list exporting function. It supports that the all devices’ data, include 

device type and quantity, had configured in the project file, can be exported to a *.xls form sheet 

file, according to a prescribed list form. 

Click software menu: “Tools --- > Export Device List”, the Save window is displayed. Select the 

directory path and enter file name, and then click “Save” button to export a device list. 

 

 

Upload Project File from DCS to PC 

To make maintainer to check or change configuration easily, each DCS will automatically save all 

configuration files of system, audio files are excluded. Maintainer can upload project files from any 

DCS through configuration software. Following are the steps: Click software menu: “Tools” ” --- >” 

Upload Project File from DCS to PC”, below window is displayed: 

 

Input an IP address of any DCS, and click upload.  The configuration files with audio files excluded 

will be uploaded to the certain path. 

  Note: 

If firmware version of X-DCS3000 is V3.5.2 or above, users need to input device passport when 

query. The default password is hon12345. 

 

 

 

 

 

 

 

 

 

 



 

 

Virtual Console  

Use to query device working status of a certain IP to make convenience for commissioning. 

 

Browse Log in X-DCS3000 

Log of X-DCS3000 can be queried through this software. Click software menu: “Tools --- >Browse  

 

Log in X-DCS3000”, below window is displayed: 

At the upper side, there are “DCS”, “date”, “query” and “save as” button. Only X-DCS3000 can be 

selected in DCS list. When query a log, first select name of DCS, and set the start date and end 

date. Click query and log contents will be displayed. For more contents, drag the slide bar to 

review. If there is a need to save logs in local place, click “save as” button, and select the saving 

path in window, input a name to save as txt version. 

  Note: 

If firmware version of X-DCS3000 is V3.5.2 or above, users need to input device passport when 

query. The default password is hon12345. 

 



 

 

Browse log in X-NPMS 

Log of X-NPMS can be queried through this software. Click software menu: “Tools --- > Browse 

Log in X-NPMS”, below window is displayed: 

 

At the upper side, there are “X-NPMS”, “date”, “query” and “save as” button. When query a log, first 

select name of X-NPMS, and set the start date and end date. Click query and log contents will be 

displayed. For more contents, drag the slide bar to review. Clicking “save as” button can save the 

logs in local position, and select the saving path in window, input a name to save as text file. 

 Note: 

If firmware version of X-NPMS is V3.5.22 or above, users need to input device passport when 

query. The default password is hon12345. 

 

Upgrade DCS/NRI/X-NPMS Firmware 

The application of DCS, NRI and X-NPMS can be upgraded through this software. Click software 

menu: “Tools--- >Upgrade DCS/NRI/X-NPMS Firmware”, the window is displayed as shown below: 

 

The following software version message or items, such as IP address, device type, file system 

version, Kernel version, App version, MAC address, MCU version and device ID, are displayed in 

the upper of the window. Enter the IP address of the device, click Firmware Query, and the above 

software version message of the current device would be displayed. 

When upgrading the firmware, please follow the below steps: 

• Click “Select” button, the Open window is displayed. 

• Select the object program file, whose format is*.bin. 

• Click Upgrade button, the progress bar and the text tips below it remind the state of the 

upgrade. 



 

 

  Note: 

If firmware version of X-DCS3000 is V3.5.2 or above, or firmware version of X-NPMS is V3.5.22 or 

above, users need to input device passport when query upgrade. The default password is 

hon12345. 

 

Upgrade X-NPMI Firmware 

The firmware of X-NPMI can be upgraded through this software. Click the menu: “Tools --- > 

Upgrade X-NPMI Firmware”, the window is displayed as shown below: 

 

Enter the IP address of X-NPMI, click Query, and the version of the current device would appear. 

When upgrading the firmware, the following steps are needed: 

• Click Select button, the Open window is displayed. 

• Select the target firmware file, the format shall be*.bin. 

• Click Upgrade button, the progress bar and the text tips below it reminds the state of the 

upgrade. 

Setup Project Passport 

It is used to setup project passport. 

 

There is no old passport setting when products leave the factory. 

 Note:  

If users set up a new passport, then every time when the project is opened, retyping the passport 

is required. 

 



 

 

Setup Device Passport 

It is used to setup device passport. The old passport of X-DCS3000/X-NPMS is hon12345. 

 

 Note: 

This function is available only if firmware version of X-DCS3000 is V3.5.2 or above, or firmware 

version of X-NPMS is V3.5.22 or above. 

Note that the device won’t be able to be used without passport. So users need to keep in mind the 

new passport it is changed.  

 

Select Language 

This software support multiple language. 

Click software menu: “Tools--- >Select Language”, the window is displayed as shown below: 

 

The users can select the language from the drop-down menu as needed, click OK to change the UI 

language. 

The software only provides 2 default language options: Simplified Chinese and English. Another 

language options can be added freely by the users, the details please refer to the next section---- 

Adding New Languages. 
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